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CHAPTER 6 
 
Entering and Editing Geometric Data 
 
   Geometric data consist of establishing the connectivity of the river system 

(River System Schematic), entering cross-section data, defining all the 
necessary junction information, adding hydraulic structure data (bridges, 
culverts, weirs, etc.) and cross section interpolation.  The geometric data is 
entered by selecting Geometric Data from the Edit menu on the HEC-RAS 
main window.  Once this option is selected, the Geometric Data window will 
appear as shown in Figure 6.1.  The drawing area will be blank on your 
screen, until you have drawn in your own river system schematic. 

 
   This chapter describes how to enter and edit all of the necessary geometric 

data for a river system.   
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Developing the River System Schematic 
 
   Building The Schematic 
 
   The modeler develops the geometric data by first drawing in the river system 

schematic on the Geometric Data window (Figure 6.1).  The River System 
Schematic is a diagram of how the stream system is connected together.  The 
river system is drawn on a reach-by-reach basis, by pressing the River Reach 
button and then drawing in a reach from upstream to downstream (in the 
positive flow direction).  Each reach is identified with a River Name and a 
Reach Name.  The River Name should be the actual name of the stream, 
while the reach name is an additional qualifier for each hydraulic reach within 
that river.  A river can be comprised of one or more reaches.  Reaches start or 
end at locations where two or more streams join together or spilt apart.  
Reaches can also start or end at the open ends of the river system being 
modeled.  In other words, the first and last cross section that will be modeled 
in a particular river will be the start or end of a particular reach.  
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   Figure 6.1  Geometric Data Editor Window 
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   Reaches are drawn as multi-segmented lines.  Each reach must have at least 
two points, defining the start and end of the reach.  However, it is more 
typical to draw a reach with several points that would follow along the main 
channel invert of the stream.  To draw a reach, first press the River Reach 
button at the top of the Geometric Data editor, on the tools button bar.  Move 
the mouse pointer to the location on the drawing area that you would like to 
have the reach begin (upstream end of the reach).  Click the left mouse button 
once to define the first point of the reach.  Move the mouse and continue to 
click the left mouse button to add additional points to the reach.  To end a 
reach, move the mouse pointer to the location in which you would like the 
last point of the reach to be located, then double click the left mouse button.  
After the reach is drawn, the user is prompted to enter the River Name and 
the Reach Name to identify the reach.  The river and reach identifiers are 
limited to sixteen characters in length.  If a particular River Name has already 
been entered for a previously defined reach of the same river, the user should 
simply select that river name from the list of available rivers in the river name 
text box.  As reaches are connected together, junctions are automatically 
formed by the interface.  The modeler is also prompted to enter an identifier 
for each junction.  Junctions are locations where two or more streams join 
together or split apart.  Junction identifiers are also limited to sixteen 
characters.  An example of a simple stream system schematic is shown in 
Figure 6.1. 

 
   In addition to river reaches, the user can draw Storage Areas, Storage Area 

Connections, and Pump Stations.  A storage area is used to define an area in 
which water can flow into and out of.  The water surface in a storage area is 
assumed to be a level pool.  Storage areas can be connected to river reaches 
as well as other storage areas.  The user connects a storage area to a reach by 
using the lateral structure option.  Storage areas can be connected to other 
storage areas by using a storage area connection between the storage areas.  
Storage area connections consist of culverts, gated spillways and a weir.  The 
user can set up a storage area connection as just a weir, a weir and culverts, or 
a weir and gated spillways.  For connections between a storage area and a 
river reach, the lateral structure option is the only means of doing this in 
HEC-RAS. 

 
   To draw a Storage Area, select the storage area button at the top of the 

geometric editor window.  Storage areas are drawn as polygons.  Move the 
mouse pointer to the location in which you would like to start drawing the 
storage area.  Press the left mouse button one time to start adding points to 
define the storage area.  Continue using single left mouse clicks to define the 
points of the storage area.  To end the storage area use a double left mouse 
click.  The storage area will automatically be closed into a polygon.  Once 
you have finished drawing the storage area, a window will appear asking you 
to enter a name for the storage area.  To enter and edit the data for a storage 
area, use the storage area editor button on the left panel of the geometric data 
window. 
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   To enter a Storage Area Connection, select the storage area connection 
button at the top of the Geometric data editor.  Move the mouse pointer to the 
storage area that you want to connect from.  Then click the left mouse pointer 
one time to start the drawing of the connection.  You can continue to use 
single mouse clicks to add as many points as you want into the line that 
represents the storage area connection.  When you want to end the 
connection, place the mouse pointer over the storage area that you want to 
connect to, and then double click the mouse pointer.  A window will pop up 
asking you to enter a name for the storage area connection.  The direction in 
which you draw the storage area connection is important for establishing the 
positive flow direction for the flow.  If you want the program to output 
positive flow when the flow is going from one storage area to another storage 
area, then you must draw the connection in that order.  This is establishing the 
positive flow direction for the storage area connection.  If flow happens to go 
in the other direction during the calculations, that flow will be output as 
negative numbers.  To enter and edit the data for a storage area connection 
use the Storage Area Connection data editor on the left panel of the 
geometric data window. 

 
   Pump stations can be connected between two storage areas, between a storage 

area and a river reach, or between two river reaches.  To add a pump station 
to the schematic, click the Pump Station button at the top, under the tools 
button bar, and then left click on the schematic at the location where you want 
to place the pump station.  To connect the pump station, either left click over 
top of the pump station and select edit, or just click on the pump station editor 
from the edit tool bar.  Connecting pumps is accomplished by picking from 
and to locations from the pump data editor. 

 
   Adding Tributaries into an Existing Reach  
 
   If you would like to add a tributary or bifurcation into the middle of an 

existing reach, this can be accomplished by simply drawing the new reach, 
and connecting it graphically to the existing reach at the location where you 
would like the new junction to be formed.  Once the new reach is connected 
into the middle of an existing reach, you will first be prompted to enter a 
River and Reach identifier for the new reach.  After entering the river and 
reach identifiers, you will be asked if you want to "Split" the existing reach 
into two reaches.  If you answer "yes", you will be prompted to enter a Reach 
identifier for the lower portion of the existing reach and a Junction name for 
the newly formed stream junction. 

 
 
   Editing The Schematic 
 
   There are several options available for editing the river system schematic. 

These options include: changing labels, moving objects (such as labels, 
junctions, and points in a reach), adding points to a reach or storage area, 
deleting points in a reach or storage area, deleting entire reaches, deleting 
junctions, numerically editing the reach schematic lines, and numerically 
editing the cross section schematic lines.  Editing functions for the schematic 

 6-4



Chapter 6  Entering and Editing Geometric Data 

are found under the Edit menu of the geometric data window.  When a 
specific editing function is selected, the interaction of the user with the 
schematic is restricted to performing that type of operation.  When the user is 
finished performing that editing function they should turn off that editing 
function by selecting it again from the Edit menu.  When none of the editing 
functions are turned on, the schematic goes back to the default mode of 
interaction.  The default interaction mode for the schematic is described in the 
"Interacting with the Schematic" section of this document.  A description of 
each editing function follows: 

 
   Change Name:  This option allows the user to change the identifiers of any 

reach or junction.  To change an identifier, you must be in the Change Name 
edit mode.  This is accomplished by selecting the Change Name option from 
the Edit menu.  Once you are in the Change Name edit mode, you then select 
the particular label that you would like to change by clicking the left mouse 
button over that label.  When a label is selected, a pop up window will appear 
allowing you to enter a new label.  The user can continue to change names by 
simply selecting the next label to be changed.  The Change Name option can 
only be turned off by re-selecting it from the edit menu or by selecting any 
other edit option. 

 
   Move Object:  This option allows you to move any label, junction, or point 

in a reach.  This is accomplished by first selecting Move Object from the 
Edit menu, then selecting the particular object that you would like to move.  
To select an object and then move it, simply place the mouse pointer over the 
object, then press the left mouse button down.  Move the object to the desired 
location and then release the left mouse button.  The Move Object option 
will remain in effect until the user either turns it off (which is accomplished 
by re-selecting it) or selects any other edit option. 

 
   Add Points to a Reach od SA: This option allows the user to add additional 

points to the line that defines a reach or a storage area.  This allows the user 
to make the schematic look more like the actual river system.  To add 
additional points, first select Add Points to a Reach or SA from the Edit 
menu.  Move the mouse pointer to the location in which you would like to 
add an additional point on the reach line, then click the left mouse button.  
After you have finished adding points to a reach, you can move them around 
by selecting the Move Object option from the Edit menu.  To turn the "Add 
Points to a Reach or SA" mode off, simply re-select it from the Edit menu, or 
select any other edit function. 

 
   Remove Points in a Reach or SA: This option allows the user to remove 

points from a reach line or a storage area.  To use this option, first select 
Remove Points in a Reach or SA from the Edit menu.  Move the mouse 
pointer over the point that you would like to delete and then click the left 
mouse button.  This option can only be turned off by either re-selecting the 
option from the Edit menu or by selecting another edit function. 

 
   Delete Reach:  This option is used to delete a reach.  This is accomplished by 

selecting the Delete Reach option from the Edit menu.  A list box containing 
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all the available reaches will appear allowing you to select those reaches that 
you would like to delete.  Warning - Be careful when you delete reaches.  
When you delete a reach, all of its associated data will be deleted also. 

 
 Delete Junction:  This option is used to delete a junction.  This is 

accomplished by selecting the Delete Junction option from the Edit menu. A 
list box containing all the available junctions will appear allowing you to 
select those junctions that you would like to delete. 

 
 Delete Storage Area:  This option is used to delete a storage area.  This is 

accomplished by selecting Delete Storage Area from the Edit menu.  A 
selection box will appear allowing you to pick the storage areas that you 
would like to delete. 

 
 Delete Storage Connection:  This option is used to delete a storage area 

connection.  This is accomplished by selecting the Delete Storage Conn 
option from the Edit menu. A list box containing all the available storage 
area connections will appear allowing you to select the ones that you would 
like to delete. 

 
 Delete Pump Station:  This option allows the user to select one or more 

pump stations to be deleted from the schematic.  This is accomplished by 
selecting Delete Pump Station from the Edit menu.  A list box containing all 
the available pump stations will appear allowing you to select the ones that 
you would like to delete. 

 
 Delete Nodes (XS, Bridges, Culverts, …):  This option allows the user to 

delete multiple locations at one time.  For example, you can delete multiple 
cross sections at one time with this option.  When this option is selected, a 
window will appear allowing you to select all of the nodes (cross sections, 
bridges, culverts, etc.) that you would like to delete. 

 
   Reach Schematic Lines: This option allows the user to numerically edit the 

coordinates of the river reach schematic lines.  When the river system 
schematic is hand drawn on the screen, the coordinates of the river reach lines 
are put into a simple coordinate system that ranges from 0.0 to 1.0 in both the 
X and Y direction.  However, the user has the option of taking real world 
coordinates (such as UTM or State Plane coordinates) off of a map and 
entering them into this table.  If the user decides to use real world 
coordinates, real world coordinates must be added for all of the reaches of the 
schematic.  If this is not done, the schematic will still be displayed in the 
simple 0.0 to 1.0 coordinate system (the hand drawn coordinates).  Once real 
world coordinates have been entered for all of the river reaches, then the 
schematic will be drawn in that coordinate system.  To enter/edit the reach 
schematic lines, select the Reach Schematic Lines option from the Edit 
menu.  Once this option is selected, a window will appear allowing the user to 
enter/edit the coordinates of any of the reaches defined in the schematic. 

 
   XS Schematic Lines: This option allows the user to numerically edit the 

coordinates of the cross section schematic lines.  When the river system is 
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hand drawn on the screen, the default coordinate system is a simple 0.0 to 1.0 
range for both the X and Y direction.  As cross sections are entered, they are 
automatically scaled based on the coordinates of the river reach line and the 
main channel distance between cross sections.  Each cross section is drawn as 
a straight line perpendicular to the river reach schematic line.  The user has 
the option of entering the real world coordinates (UTM or State Plane) of the 
cross section schematic lines.  Each cross section schematic line must have at 
least two points, a start and an end, but additional points can be added if the 
cross section was taken as a multi segmented line.  In order for the cross 
section schematic lines to be plotted in the real world coordinate system, the 
user must enter real world coordinates for all of the cross sections in the 
reach.  To enter/edit the cross section schematic lines, select the XS 
Schematic Lines option from the Edit menu.  Once this option is selected, a 
window will appear allowing the user to enter/edit the coordinates of any of 
the cross section schematic lines. 

 
   Storage Area Outlines:  This option allows the user to enter/edit the X and Y 

coordinates that define the outline of a storage area.  If you are using GIS 
data, these coordinates may be in the UTM or State Plane coordinate system.  
If you are not using GIS data, the coordinate system for the storage areas will 
just be in a 0 to 1.0 system.  The coordinates of a storage area can also be 
edited graphically by using the Move Object option from the edit menu. 

 
   GIS Levee:  This option allows the user to edit/enter the coordinates for a 

user specified levee.  Levees can be defined in the GIS system and imported 
into HEC-RAS.  The coordinates will consist of X, Y, and Z (elevation). 

 
   GIS Ineffective Flow Area:  This option allows the user to edit/enter the 

coordinates for a user specified ineffective flow areas.  Ineffective flow areas 
can be defined in the GIS system and imported into HEC-RAS.  The 
coordinates will consist of X, Y, and Z (trigger elevation for when it will be 
turned off). 

 
   Hydraulic Connection Lines:  This option allows the user to edit/enter 

coordinates for the line used to show a connection between two storage areas, 
between a storage area and a river reach, and between two river reaches.  
These lines cal also be edited graphically by using the Move Object option 
from the Edit menu. 

 
 
   Interacting With The Schematic     
 
   In addition to modifying the river schematic, there are options available to 

zoom in, zoom out, display the cross section river stationing, and reset the 
viewing extent of river system schematic.  Additionally, the user has the 
ability to use the mouse to interact with the schematic.  This is accomplished 
by moving the mouse pointer over an object (river reach line, junction, 
bridge, culvert, etc.) on the schematic and pressing down the left mouse 
button.  Once the left mouse button is pressed down, a pop up menu will 
appear with options that are specific to that type of object.  For example, 
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when the left mouse button is pressed down over a cross section, a menu will 
appear allowing the user to select options to: edit the cross section, plot the 
cross section, plot the profile for the reach that the cross section is in, display 
tabular output for the cross section, and plot the computed rating curve for 
that cross section.  Another way of interacting with the schematic is to press 
the right mouse button while the mouse pointer is located any where over the 
schematic drawing area.  This will bring up a pop up menu that is exactly the 
same as the View menu at the top of the drawing.  This option is providing 
for convenience in getting to the View menu options.  The options available 
from the View menu are as follows: 

 
   Zoom In:  This option allows the user to zoom in on a piece of the schematic.  

This is accomplished by selecting Zoom In from the View menu, then 
specifying the area to zoom in on with the mouse.  Defining the zoom area is 
accomplished by placing the mouse pointer in the upper left corner of the 
desired area.  Then press down on the left mouse button and drag the mouse 
to define a box containing the desired zoom area.  Finally, release the left 
mouse button and the viewing area will display the zoomed in schematic.  
Also displayed will be a small box in the upper right corner of the viewing 
area.  This box will contain a picture of the entire schematic, with a rectangle 
defining the area that is zoomed in.  In addition to showing you where you are 
at on the schematic, this zoom box allows you to move around the schematic 
without zooming out and then back in.  To move the zoomed viewing area, 
simply hold down the left mouse button over the rectangle in the zoom box 
and move it around the schematic.  The zoom box can also be resized.  
Resizing the zoom box is just like resizing a window. 

 
   Zoom Out:  This option zooms out to an area that is twice the size of the 

currently zoomed in window.  Zooming out is accomplished by selecting 
Zoom Out from the View menu on the geometric data window. 

 
   Full Plot: This option re-draws the plot to its full original size.  The Full Plot 

option is accomplished by selecting Full Plot from the View menu on the 
geometric data window. 

 
   Pan:  This option allows the user to move around when in a zoomed in mode.  

The pan option is accomplished by selecting Pan from the View menu of the 
geometric data window.  When this option is selected, the mouse pointer will 
turn into a hand.  Press the left mouse button and hold it down, then move the 
mouse.  This will allow the user to move the zoomed in graphic.  To turn the 
pan mode off, re-select the pan option from the view menu. 

 
   Set Schematic Plot Extents:  This option allows the user to set the extents of 

the viewing area for the river system schematic.  The user can enter a specific 
coordinate system, or utilize the default data system.  The default data plot 
extents are from 0 to 1 for both the X and Y axis. 

 
   Find:  This option allows the user to have the interface locate a specific 

feature on the schematic.  This is especially useful when very large and 
complex river systems are being modeled. 
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   Display River Stationing:  This option allows you to display river station 
identifiers on the schematic.  This is accomplished by selecting Display 
River Stationing from the View menu on the geometric data window. 

 
   Display Bank Stations:  This option allows the user to display the main 

channel bank stations on the cross section lines of the schematic.  This is 
accomplished by selecting Display Bank Stations from the View menu of 
the geometric data window. 

 
   Display Ineffective Areas:  This option allows the user to display the 

location of ineffective flow areas on top of the cross section lines of the 
schematic.  This is accomplished by selecting Display Ineffective Areas 
from the View menu of the geometric data window.  

 
   Display Levees:  This option allows the user to display the location of levees 

on the cross section lines of the schematic.  This is accomplished by selecting 
Display Levees from the View menu of the geometric data window.  

 
   Display XS Direction Arrows:  This option allows the user to display arrows 

along the cross sections in the direction in which they were extracted.  This 
option is useful when you have coordinates defined for the cross section, such 
that the software can detect the direction that the cross section was extracted.  
Cross-sections are suppose to be entered from left to right while looking 
downstream.  If a cross section has not been entered in this manner, it should 
be reversed.  HEC-RAS has an option to reverse the cross section stationing.  
This option can be found under the Tools menu bar of the geometric data 
editor.   To display the cross section direction arrows, select Display XS 
Direction Arrows from the View menu of the geometric data window. 

 
   Fill in Storage Areas: This option allows the user to turn on and off the fill 

in color for the storage areas.  Turning this off is very useful when a 
background picture is loaded. 

 
   Background Pictures.  
 
   Another option available to users is the ability to add background images for 

displayed behind the river system schematic.  One or more pictures can be 
added.  To enter a background picture, press the background picture button on 
the Tools menu bar (far right button).  Select the add button to find a picture 
file to use as a background image.  The software will automatically look for a 
companion file to the image, called a world file.  This file contains 
information about the image, including the coordinate system and the extents 
of the image.  The user has the option of rectifying the picture by entering 
coordinates for the left, right, top, and bottom sides of the picture, with 
respect to the coordinates of the river system schematic.  If coordinates are 
not entered for the extent of the picture, the size of the picture will be based 
on its resolution and the resolution of your screen.  Several graphical formats 
are supported for background maps, including: ESRI shape files (.shp); Cad 
files (.dgn, .dxf, .dwg); Windows bitmap (.bmp, .dip); Tiff and GeoTiff (.tif, 
.tff, .tiff); JFIF (.jpg, .jpeg); MrSID (.sid), and others. 
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Cross Section Data 
 
   After the river system schematic is completed, the next step for the modeler is 

to enter the cross section data.  Cross section data represent the geometric 
boundary of the stream.  Cross sections are located at relatively short intervals 
along the stream to characterize the flow carrying capacity of the stream and 
its adjacent floodplain.  Cross sections are required at representative locations 
throughout the stream and at locations where changes occur in discharge, 
slope, shape, roughness, at locations where levees begin and end, and at 
hydraulic structures (bridges, culverts, inline weirs/spillways, and lateral 
weirs/spillways).   

 
 
   Entering Cross Section Data 
 
   To enter cross section data, the user presses the Cross Section button on the 

Geometric Data window (Figure 6.1).  Once the cross section button is 
pressed, the Cross Section Data Editor will appear as shown in Figure 6.2 
(except yours will be blank until you have added some data).  To add a cross 
section to the model, the user must do the following: 

 
   1. From the Cross Section Editor, select the river and the reach that you 

would like to place the cross section in.  This is accomplished by 
pressing the down arrow on the River and Reach boxes, and then 
selecting the river and reach of choice. 

 
   2. Go to the Options menu and select Add a new Cross Section from 

the list.  An input box will appear prompting you to enter a river 
station identifier for the new cross section. 

 
   3. Enter all of the required data for the new cross section.  Required data 

is the data that is openly displayed in the cross section editor window.  
 
   4. Enter any desired optional information (i.e., ineffective flow areas, 

levees, blocked obstructions, etc.).  Optional cross section information 
is found under the Options menu.   

 
   5. Press the Apply Data button in order for the interface to accept the 

data.  The apply data button does not save the data to the hard disk, it 
is used as a mechanism for telling the interface to use the information 
that was just entered.  If you want the data to be saved to the hard disk 
you must do that from the File menu on the geometric data window. 

 
   The required information for a cross section consists of: the river, reach and 

river station identifiers; a description; X & Y coordinates (station and 
elevation points); downstream reach lengths; Manning’s roughness 
coefficients; main channel bank stations; and contraction and expansion 
coefficients.  All of the required information is displayed openly on the Cross 
Section Data editor (Figure 6.2).  A description of this information follows: 
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   Figure 6.2  Cross Section Data Editor 
 
   River, Reach, and River Station.  The River and Reach boxes allow the user 

to select a specific hydraulic reach from the available reaches in the 
schematic diagram.  The river and reach labels define which reach the cross 
section will be located in.  The River Station tag defines where the cross 
section will be located within the specified reach.  The river station tag does 
not have to be the actual river station of the cross section, but it must be a 
numeric value.  Cross sections are ordered in the reach from highest river 
station upstream to lowest river station downstream.  The up and down arrow 
buttons next to the river station box can be used to sequentially move through 
the river stations. 

 
   Description.  The description box is used to describe the cross section 

location in more detail than just the river, reach, and river station.  This box 
has a limit of 512 characters.  The first line of information is displayed, unless 
the button to the right of the box is pressed.  Also, the first 40 characters of 
the description are used as a label for cross section plots and tables. 

 
   Cross Section X & Y Coordinates.  This table is used to enter the station 

and elevation information of the cross section.  Station and elevation 
information is entered in feet (meters for metric).  The cross section 
stationing (x-coordinates) are entered from left to right looking in the 
downstream direction.  Cross section stationing must be in increasing order.  
However, two or more stations can have the same value to represent vertical 
walls. 
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   Downstream Reach Lengths.  The downstream cross section reach lengths 
describe the distance between the current cross section and the next cross 
section downstream.  Cross section reach lengths are defined for the left 
overbank, main channel, and the right overbank.  Cross section reach lengths 
are entered in feet (meters for metric). 

 
   Manning's n Values.  At a minimum, the user must specify Manning's n 

values for the left overbank, main channel, and the right overbank.  
Alternative roughness options are available from the Options menu. 

 
   Main Channel Bank Stations.  The main channel bank stations are used to 

define what portion of the cross section is considered the main channel and 
what is considered left and right overbank area.  The bank stations must 
correspond to stations entered on the cross section X & Y coordinates table.  
If the user enters a value that does not correspond to the station points of the 
cross section, the interface will ask the user if they would like the value to be 
automatically interpolated and added to the cross section data. 

 
   Contraction & Expansion Coefficients.  Contraction and expansion 

coefficients are use to evaluate the amount of energy loss that occurs because 
of a flow contraction or expansion.  The coefficients are multiplied by the 
change in velocity head from the current cross section to the next downstream 
cross section.  In other words, the values entered at a particular cross section 
are used to compute losses that occur between that cross section and the next 
downstream cross section. 

 
   Once all of the required data for the cross section are entered, make sure you 

press the Apply data button to ensure that the interface accepts the data that 
was just entered.   

 
   Editing Cross Section Data 
 
   The bulk of the cross section data is the station and elevation information.  

There are several features available under the Edit menu to assist the user in 
modifying this information.  These features include the following: 

 
   Undo Editing.  This editing feature applies to all of the information on the 

cross section data editor.  Once data has been entered and the Apply Data 
button has been pressed, the Undo Editing feature is activated.  If any 
changes are made from this point, the user can get the original information 
back by selecting the Undo Edit option from the Edit menu.  Once the Apply 
Data button is pressed, the new information is considered good and the Undo 
Edit feature is reset to the new data. 

 
   Cut, Copy, and Paste.  Cut, Copy, and Paste features are available for the 

station and elevation information on the cross section editor.  These features 
allow the user to pass cross section station and elevation data to and from the 
Windows Clipboard.  To use this feature, first highlight a cell or multiple 
cells on the station and elevation table.  Cells are highlighted by pressing 
down on the left mouse button and moving it over the cells that you would 
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like to be highlighted.  Next select either the Cut or Copy feature from the 
Edit menu.  If Cut is selected, the information is placed in the Windows 
Clipboard and then it is deleted from the table.  If Copy is selected, the 
information is placed in the Windows Clipboard, but it also remains in the 
table.  Once the information is in the Windows Clipboard it can be pasted into 
the station and elevation table of any cross section.  To paste data into another 
cross section, first go to the cross section in which you would like the data to 
be placed.   Highlight the area of the table in which you want the data to be 
placed. Then select the Paste option from the Edit menu.  The cut, copy, and 
paste features can also be used to pass station and elevation information 
between HEC-RAS and other programs. 

 
   Delete.  This option allows the user to delete a single cell or multiple cells in 

the station/elevation table.  Once the cells are deleted, everything below those 
cells is automatically moved up.  To use this option, first highlight the cells 
that you would like to delete, then select the Delete option from the Edit 
menu.  If you would like to clear cells, without moving the data below those 
cells, simply highlight the cells and press the delete key.  

 
   Insert.  This option allows the user to insert one or several rows in the middle 

of existing data in the station/elevation table.  To use this option, first 
highlight the area in the table that you would like to be inserted.  Then select 
Insert from the Edit menu.  The rows will be inserted and all of the data will 
be moved down the appropriate number of rows.  The user can also insert a 
single row by placing the curser in the row just below where you would like 
the new row to be inserted.  Then select Insert from the Edit menu.  The row 
will be inserted and all of the data below the current row will be moved down 
one row. 

 
   Cross Section Options 
 
   Information that is not required, but is optional, is available from the Options 

menu at the top of the cross section data editor window (Figure 6.2).  Options 
consist of the following: 

 
   Add a new Cross Section.  This option initiates the process of adding a cross 

section to the data set.  The user is prompted to enter a river station tag for the 
new cross section.  The river station tag locates the cross section within the 
selected reach.  Once the river station is entered, the cross section data editor 
is cleared (except for some default values that get set) and the user can begin 
entering the data for the cross section.  Whenever a new cross section is 
added to the data set, default values will appear for the contraction and 
expansion coefficients (0.1 and 0.3 respectively).  Also, if the new cross 
section is not the first or most upstream cross section of the reach, the 
program will set default Manning’s n values equal to the n values of the cross 
section just upstream of the new cross section.  If the user does not want these 
default values, they can simply change them to whatever values they would 
like. 
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   Copy Current Cross Section.  This option allows the user to make a copy of 
the cross section that is currently displayed in the editor.  When this option is 
selected, the user is prompted to select a river and reach for the new section, 
and then enter the a river station.  Once the information is entered, the new 
cross section is displayed in the editor.  At this point it is up to the user to 
change the description and any other information about the cross section.  
This option is normally used to make interpolated cross sections between two 
surveyed cross sections.  Once the section is copied, the user can adjust the 
elevations and stationing of the cross section to adequately depict the 
geometry between the two surveyed sections. 

 
   Rename River Station.  This option allows the user to change the River 

Station of the currently displayed cross section. 
 
   Delete Cross Section.  This option will delete the currently displayed cross 

section.  The user is prompted with a message stating specifically which cross 
section is going to be deleted, and requesting the user to press the OK button 
or the Cancel button.  Once the OK button is pressed, the user will be 
prompted with a question of whether or not they would like the cross section 
reach lengths to be automatically adjusted to account for the removal of the 
cross section.  If the user answers YES then the reach lengths of the current 
cross section, that is being deleted, will be added to the reach lengths of the 
next upstream cross section.  If the user answers NO, then the cross section 
will be deleted with out adjusting any reach lengths. 

 
   Adjust Elevations.  This option allows the user to adjust all of the elevations 

of the currently displayed cross section.  Positive or negative elevation 
changes can be entered.  Once the value is entered, the interface automatically 
adjusts all the elevations in the table. 

 
   Adjust Stations.  This option allows the user to adjust the stationing of the 

currently displayed cross section.  Two options are available.   The first 
option (Multiply by a Factor) allows the user to separately expand and/or 
contract the left overbank, main channel, and the right overbank.  When this 
option is selected, the user is prompted to enter a multiplier for each of the 
three flow elements (left overbank, main channel, and right overbank).   If the 
multiplier is less than one, the flow element is contracted.  If the multiplier is 
greater than one, the flow element is expanded.  Once the information is 
entered, and the user hits the OK button, the interface automatically performs 
the contraction and/or expansions.   The cross section should be reviewed to 
ensure that the desired adjustments were performed.  The second option (Add 
a Constant) allows the user to add or subtract a constant value from all the 
stations in the cross section.  This would allow the entire cross section to be 
shifted to the right or the left. 

 
   Adjust n or k Values.  This option allows the user to either increase or 

decrease all the n or k values of the current cross section.  The user is 
prompted for a single value.  This value is then used as the multiplier for all 
of the n or k values of the current cross section. 
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   Skew Cross Section.  This option allows the user to adjust the stationing of a 
cross section based on a user entered skew angle.  Cross-sections are suppose 
to be taken perpendicular to the flow lines.  This may not always be the case, 
such as at bridges.  In order for the program to use the correct flow area, the 
cross section stationing must be adjusted by taking the cosine of the skew 
angle times the stationing.  When this option is selected, a window will 
appear allowing the user to enter a skew angle.  Once the angle is entered, the 
software will automatically adjust the cross section stationing.  The user can 
get back to the original stationing by putting a zero skew into the field. 

 
   Ineffective Flow Areas.  This option allows the user to define areas of the 

cross section that will contain water that is not actively being conveyed 
(ineffective flow).  Ineffective flow areas are often used to describe portions 
of a cross section in which water will pond, but the velocity of that water, in 
the downstream direction, is close to or equal to zero.  This water is included 
in the storage calculations and other wetted cross section parameters, but it is 
not included as part of the active flow area.  When using ineffective flow 
areas, no additional wetted perimeter is added to the active flow area.  An 
example of an ineffective flow area is shown in Figure 6.3.  The cross-
hatched area on the left of the plot represents the ineffective flow area. 

 
   Two alternatives are available for setting ineffective flow areas.  The first 

option allows the user to define a left station and elevation and a right station 
and elevation (normal ineffective areas).  When this option is used, and if 
the water surface is below the established ineffective elevations, the areas to 
the left of the left station and to the right of the right station are considered 
ineffective.  Once the water surface goes above either of the established 
elevations, then that specific area is no longer considered ineffective.  In other 
words, the program now assumes that the area will be conveying water in the 
downstream direction, such that it now uses that area in the conveyance 
calculations of the active flow area.  However, the user has the option to set 
the ineffective flow areas to permanent, which will prevent them from turning 
off.  When this option is used, water is allowed to go over top of the 
ineffective flow area. 

 
   The second option allows for the establishment of blocked ineffective flow 

areas.  Blocked ineffective flow areas require the user to enter an elevation, a 
left station, and a right station for each ineffective block.  Up to ten blocked 
ineffective flow areas can be entered at each cross section.  Once the water 
surface goes above the elevation of the blocked ineffective flow area, the 
blocked area is no longer considered ineffective.  However, the user has the 
option to set the blocked ineffective flow areas to permanent, which will 
prevent them from turning off.  When this option is used, water is allowed to 
go over top of the ineffective flow area. 
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Left Ineffective
Flow Station

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   Figure 6.3  Cross section with ineffective flow areas 
 
 
   
   Levees.  This option allows the user to establish a left and/or right levee 

station and elevation on any cross section.  When levees are established, no 
water can go to the left of the left levee station or to the right of the right 
levee station until either of the levee elevations are exceeded.  Levee stations 
must be defined explicitly, or the program assumes that water can go 
anywhere within the cross section.  An example of a cross section with a 
levee on the left side is shown in Figure 6.4.  In this example the levee station 
and elevation is associated with an existing point on the cross section.  

 
   The user may want to add levees into a data set in order to see what effect a 

levee will have on the water surface.  A simple way to do this is to set a levee  
   station and elevation that is above the existing ground.  If a levee elevation is 

placed above the existing geometry of the cross section, then a vertical wall is 
placed at that station up to the established levee height.  Additional wetted 
perimeter is included when water comes into contact with the levee wall.  An 
example of this is shown in Figure 6.5. 
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Left Levee
Station

Left Levee Station
and Eleveation

 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   Figure 6.4  Example of the Levee Option 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.5  Example Levee Added to a Cross Section

 6-17



Chapter 6  Entering and Editing Geometric Data 

Obstructions.  This option allows the user to define areas of the cross section 
that will be permanently blocked out.  Obstructions decrease flow area and 
add wetted perimeter when the water comes in contact with the obstruction.  
An obstruction does not prevent water from going outside of the obstruction.   

 
   Two alternatives are available for entering obstructions.  The first option 

allows the user to define a left station and elevation and a right station and 
elevation (normal obstructions).  When this option is used, the area to the 
left of the left station and to the right of the right station will be completely 
blocked out.  An example of this type of obstruction is shown in Figure 6.6. 

 

 
    
   Figure 6.6  Example of Normal Obstructions 
 
   The second option, for obstructions, allows the user to enter up to 20 

individual blocks (blocked obstructions).  With this option the user enters a 
left station, a right station, and an elevation for each of the blocks.  An 
example of a cross section with blocked obstructions is shown in Figure 6.7. 
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   Figure 6.7  Example of a Cross Section With Blocked Obstruction 
 
 
   Add a Lid to XS.  This option allows the user to add a lid (similar to a bridge 

deck/roadway) to any cross section.  This is commonly used when trying to 
model a long tunnel.  The ground geometry can be used to describe the 
bottom half of the tunnel, while the lid can describe the top half.  A lid can be 
added to any number of cross sections in a row.  The program treats cross 
sections with lids just like any other cross section.  The energy equation is 
used to balance a water surface, with the assumption of open channel flow.  
The only difference is that the program will subtract out area and add wetted 
perimeter when the water surface comes into contact with the lid.  

 
   Add Ice Cover.  This option allows the user to enter ice cover for the 

currently opened cross section.  For a detailed discussion of ice cover, and ice 
modeling, please review the section called Modeling Ice Cover later in this 
chapter.  

 
   Add a Rating Curve.  This option allows the user to add a rating curve to a 

cross section as an alternative to the program computing the water surface.  
The user is required to enter flow versus elevation information for the rating 
curve.  When the program is executed in a steady flow mode, the program 
will interpolate a water surface elevation from the rating curve for the given 
flow of a particular profile. 
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than three Manning's n values for the current cross section.  When this option 
is selected, an additional column for n values is added to the cross section 



Chapter 6  Entering and Editing Geometric Data 

coordinates table as shown in Figure 6.8.  A Manning's n value must be 
placed in the first row of the table.  This n value is good for all cross section 
stations until a new n value shows up in the table.  The user does not have to 
enter an n value for every station, only at the locations where the n value is 
changing.   

     
   

 
   

  Figure 6.8  Cross section with horizontal variation of n values selected 
 
 
   Horizontal Variation in k Values.  This option allows the user to enter k 

values (roughness heights) instead of n values.  The k values are entered in 
the same manner as the horizontal variation of n values.  To learn more about 
k values and how they are used in the program, see Chapter 3 of the 
Hydraulic Reference manual. 

 
   Vertical Variation in n Values.  This option allows the user to enter 

Manning’s n values that vary both horizontally as well as vertically.  The user 
can vary the n value either by elevation or by flow.  When this option is 
selected a window will appear as shown in Figure 6.9.  The user enters the 
stationing for horizontal changes in n values across the top in row 0 (these 
stations are entered in the same manner as the horizontal variation of 
Manning’s n value option).  The elevations in which changes occur are 
entered in the first column.  Then the actual Manning’s n values are entered in 
rows 1-20 (columns 2-21).  The program will interpolate Manning’s n values 
whenever the actual water surface is between the entered elevations.  If the 
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water surface is below the first elevation entered, then the values from that 
elevation will be used.  Likewise, if the water surface is above the last 
elevation entered, the program will use the n values from the last elevation 
specified.  No extrapolation is done on either side of the user entered values. 

 

 
Figure 6.9  Vertical Variation of Manning’s n Values Window 
 
 
Plotting Cross Section Data 

 
   Once all the data have been entered for a cross section, you should plot the 

cross section to inspect it for possible data errors.  To plot the current cross 
section from the cross section editor, select Plot Cross Section from the Plot 
menu. 

 
 
 
Stream Junctions 
 
   Entering Junction Data 
    
   Stream junctions are defined as locations where two or more streams come 

together or split apart.  Junction data consist of a description, reach lengths 
across the junction, tributary angles, and modeling approach.  To enter 
junction data the user presses the Junction button on the Geometric Data 
window (Figure 6.1).  Once the junction button is pressed, the junction editor 
will appear as shown in Figure 6.10.   
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  Figure 6.10  Junction Data Editor 
 
 
   The junction editor will come up with one of the junctions loaded. Fill out the 

description and reach lengths for the junction.  Reach lengths across the 
junction are entered here instead of the cross section data editor.  This allows 
for the lengths across very complicated confluences (i.e., flow splits) to be 
accommodated.  In the cross section data, the reach lengths for the 
downstream cross section of each reach should be left blank or set to zero.   

 
 
   Selecting A Modeling Approach 
 
   In HEC-RAS a junction can be modeled by either the energy equation or the 

momentum equation.  The energy equation does not take into account the 
angle of a tributary coming in or leaving, while the momentum equation does.   
In most cases the amount of energy loss due to the angle of the tributary flow 
is not significant, and using the energy equation to model the junction is more 
than adequate.  However, there are situations where the angle of the tributary 
can cause significant energy losses.  In these situations it would be more 
appropriate to use the momentum approach.  When the momentum approach 
is selected, an additional column is added to the table next to the junction 
lengths.  This column is used to enter an angle for any river reach that is 
coming into or exiting the main river.  For the reaches that are considered to 
be the main river, the angle should be left blank or set to zero.  Also, the user 
has the option to turn friction and weight forces on or off during the 
momentum calculations.  The default is to have the weight force turned off. 

 
   If there is more than one junction in the river schematic, the other junctions 

can be selected from the Junction Name box at the upper left corner of the 
window.   Enter all the data for each junction in the river system, then close 
the window by pressing the OK button in the lower left corner of the window.  
When the junction data editor is closed the data are automatically applied. 
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Bridges and Culverts 
 
   Once all of the necessary cross-section data have been entered, the modeler 

can then add any bridges or culverts that are required.  HEC-RAS computes 
energy losses caused by structures such as bridges and culverts in three parts.  
One part consists of losses that occur in the reach immediately downstream 
from the structure where an expansion of flow takes place.  The second part is 
the losses at the structure itself, which can be modeled with several different 
methods.  The third part consists of losses that occur in the reach immediately 
upstream of the structure where the flow is contracting to get through the 
opening. 

 
   The bridge routines in HEC-RAS allow the modeler to analyze a bridge with 

several different methods without changing the bridge geometry.  The bridge 
routines have the ability to model low flow (Class A, B, and C), low flow and 
weir flow (with adjustments for submergence), pressure flow (orifice and 
sluice gate equations), pressure and weir flow, and high flows with the energy 
equation only.  The model allows for multiple bridge and/or culvert openings 
at a single location. 

 
 The culvert hydraulics in HEC-RAS are based on the Federal Highway 

Administrations (FHWA) standard equations from the publication Hydraulic 
Design of Highway Culverts (FHWA, 1985).  The culvert routines include the 
ability to model circular, box, elliptical, arch, pipe arch, low profile arch, high 
profile arch, and semi circular culverts.  The HEC-RAS program has the 
ability to model multiple culverts at a single location.  The culverts can have 
different shapes, sizes, elevations, and loss coefficients.  The user can also 
specify the number of identical barrels for each culvert type. 

 
 
   Cross Section Locations 
 
   The bridge and culvert routines utilize four user defined cross sections in the 

computations of energy losses due to the structure.  A plan view of the basic 
cross section layout is shown in Figure 6.11.   

 
   Cross section 1 is located sufficiently downstream from the structure so that 

the flow is not affected by the structure (i.e., the flow has fully expanded).  
This distance should generally be determined by field investigation during 
high flows.  Generally, field investigation during high flows is not possible.  
The expansion distance will vary depending upon the degree of constriction, 
the shape of the constriction, the magnitude of the flow, and the velocity of 
the flow.  Table 6.1 offers ranges of expansion ratios, which can be used for 
different degrees of constriction, different slopes, and different ratios of the 
overbank roughness to main channel roughness.  Once an expansion ratio is 
selected, the distance to the downstream end of the expansion reach (the 
distance Le on Figure 6.11) is found by multiplying the expansion ratio by the 
average obstruction length (the average of the distances A to B and C to D 
from Figure 6.11).   
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  Figure 6.11  Cross Section Locations at a Bridge or Culvert  
 
 

The average obstruction length is half of the total reduction in floodplain 
width caused by the two bridge approach embankments.  In Table 6.1, b/B is 
the ratio of the bridge opening width to the total floodplain width, nob is the 
Manning n value for the overbank, nc is the n value for the main channel, and 
S is the longitudinal slope.  The values in the interior of the table are the 
ranges of the expansion ratio.  For each range, the higher value is typically 
associated with a higher discharge. 
 

Table 6.1   
Ranges of Expansion Ratios 

 
nob / nc = 1 nob / nc = 2 nob / nc = 4  

b/B = 0.10        S = 1 ft/mile 
                               5 ft/mile 
                             10 ft/mile 

1.4 – 3.6 
1.0 – 2.5 
1.0 – 2.2 

1.3 – 3.0 
0.8 – 2.0 
0.8 – 2.0 

1.2 – 2.1 
0.8 – 2.0 
0.8 – 2.0 

b/B = 0.25        S = 1 ft/mile 
                               5 ft/mile 
                             10 ft/mile  

1.6 – 3.0 
1.5 – 2.5 
1.5 – 2.0 

1.4 – 2.5 
1.3 – 2.0 
1.3 – 2.0 

1.2 – 2.0 
1.3 – 2.0 
1.3 – 2.0 

b/B = 0.50        S = 1 ft/mile 
                               5 ft/mile 
                             10 ft/mile 

1.4 – 2.6 
1.3 – 2.1 
1.3 – 2.0 

1.3 – 1.9 
1.2 – 1.6 
1.2 – 1.5 

1.2 – 1.4 
1.0 – 1.4 
1.0 – 1.4 
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   A detailed study of flow contraction and expansions at bridges was 
undertaken by the Hydrologic Engineering Center.  The results of this study 
have been published as a research document entitled "Flow Transitions in 
Bridge Backwater Analysis" (RD-42 HEC, 1995).  The purpose of this study 
was to provide better guidance to hydraulic engineers performing water 
surface profile computations through bridges.  Specifically the study focused 
on determining the expansion reach length, Le; the contraction reach length, 
Lc; the expansion energy loss coefficient, Ce; and the contraction energy loss 
coefficient, Cc.  A summary of this research, and the final recommendations, 
can be found in Appendix B of the HEC-RAS Hydraulic Reference manual. 

 
   The user should not allow the distance between cross section 1 and 2 to 

become so great that friction losses will not be adequately modeled.  If the 
modeler feels that the expansion reach will require a long distance, then 
intermediate cross sections should be placed within the expansion reach in 
order to adequately model friction losses.  The user will need to estimate 
ineffective flow areas for these intermediate cross sections. 

 
   Cross section 2 is located immediately downstream from the bridge (i.e., 

within a short distance).  This cross section should represent the natural 
ground just outside the bridge.  This section is normally located at the toe of 
the downstream bridge embankment.  

  
   Cross section 3 should be located just upstream from the bridge.  The 

distance between cross section 3 and the bridge should be relatively short.  
This distance should only reflect the length required for the abrupt 
acceleration and contraction of the flow that occurs in the immediate area of 
the opening.  Cross section 3 represents the natural ground just upstream of 
the bridge.  This section is normally located at the toe of the upstream bridge 
embankment. 

 
   Both cross sections 2 and 3 will have ineffective flow areas to either side of 

the bridge opening during low flow and pressure flow.  In order to model only 
the effective flow areas at these two sections, the modeler should use the 
ineffective flow area option.  This option is selected from the cross section 
data editor.  For a detailed discussion of how to set the ineffective flow area 
stations and elevations, see Chapter 5 of the Hydraulic Reference manual. 

 
   Cross section 4 is an upstream cross section where the flow lines are 

approximately parallel and the cross section is fully effective.  In general, 
flow contractions occur over a shorter distance than flow expansions.  The 
distance between cross section 3 and 4 (the contraction reach length, Lc) 
should generally be determined by field investigation during high flows.  
Traditionally, the Corps of Engineers recommends locating the upstream 
cross section a distance equal to one times the average length of the side 
constriction caused by the structure abutments.  The contraction distance will 
vary depending upon the degree of constriction, the shape of the constriction, 
the magnitude of the flow, and the velocity of the flow.  As mentioned 
previously, the detailed study "Flow Transitions in Bridge Backwater 
Analysis" (RD-42, HEC, 1995) was performed to provide better guidance to 
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hydraulic engineers performing water surface profile computations through 
bridges.  A summary of this research, and the final recommendations, can be 
found in Appendix B of the HEC-RAS Hydraulic Reference manual. 

 
   When the user adds a bridge at a particular river station, the program 

automatically formulates two additional cross sections inside of the bridge 
structure.  The geometry inside of the bridge is a combination of the bounding 
cross sections (2 and 3) and the bridge geometry.  The bridge geometry 
consists of the bridge deck, abutments if necessary, and any piers that may 
exist.  The user can specify different bridge geometry for the upstream and 
downstream sides of the structure if necessary.  Cross section 2 and the 
structure information on the downstream side are used as the geometry just 
inside the structure at the downstream end.  Cross section 3 and the upstream 
structure information are used as the bridge geometry just inside the structure 
at the upstream end.  The user has the option to edit these internal bridge 
cross sections, in order to make adjustments to the geometry. 

 
   For a more detailed discussion on laying out cross sections around bridges, 

the user is referred to chapter 5 of the Hydraulic Reference Manual. 
 
   Contraction and Expansion Losses 
 
   Losses due to the contraction and expansion of flow between cross sections 

are determined during the standard step profile calculations.  Contraction and 
Expansion losses are described in terms of coefficient times the absolute 
value of the change in velocity head between adjacent cross sections.  When 
the velocity head increases in the downstream direction a contraction 
coefficient is used; and when the velocity head decreases in the downstream 
direction, an expansion coefficient is used.  For a detailed discussion on 
selecting contraction and expansion coefficients at bridges, the user is 
referred to chapter 5 of the HEC-RAS Hydraulic Reference Manual. 

 
   Bridge Hydraulic Computations 
 
   Low Flow Computations.  For low flow computations the program first uses 

the momentum equation to identify the class of flow.   This is accomplished 
by first calculating the momentum at critical depth inside the bridge at the 
upstream and downstream ends.  The end with the higher momentum 
(therefore most constricted section) will be the controlling section in the 
bridge.  The momentum at critical depth in the controlling section is then 
compared to the momentum of the flow downstream of the bridge when 
performing a subcritical profile (upstream of the bridge for a supercritical 
profile).  If the momentum downstream is greater than the critical depth 
momentum inside the bridge, the class of flow is considered to be completely 
subcritical (i.e., class A low flow).  If the momentum downstream is less than 
the momentum at critical depth in the bridge, then it is assumed that the 
constriction will cause the flow to pass through critical depth and a hydraulic 
jump will occur at some distance downstream (i.e., class B low flow).  If the 
profile is completely supercritical through the bridge then this is class C low 
flow.  Depending on the class of flow the program will do the following: 
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   Class A low flow.  Class A low flow exists when the water surface through 
the bridge is completely subcritical (i.e., above critical depth).  Energy losses 
through the expansion (sections 2 to 1) are calculated as friction losses and 
expansion losses.  Friction losses are based on a weighted friction slope times 
a weighted reach length between sections 1 and 2.  The average friction slope 
is based on one of the four available alternatives in HEC-RAS, with the 
average-conveyance method being the default.  This option is user selectable.  
The average length used in the calculation is based on a discharge-weighted 
reach length.  

 
   There are four methods for computing losses through the bridge (from 2 to 3): 
 
    - Energy equation (standard step method) 
 
    - Momentum balance 
 
    - Yarnell equation 
 
    - FHWA WSPRO method 
 
   The user can select any or all of these methods in the computations.  If more 

than one method is selected, the user must choose either a single method as 
the final solution or tell the program to use the method that computes the 
greatest energy loss through the bridge as the answer at section 3.  This 
allows the modeler to compare the answers from several techniques all in a 
single execution of the program.  Minimal results are available for all the 
methods computed, but detailed results are available for the method that is 
selected as the final answer. 

 
   Energy losses through the contraction (sections 3 to 4) are calculated as 

friction losses and contraction losses.  Friction and contraction losses between 
sections 3 and 4 are calculated the same as friction and expansion losses 
between sections 1 and 2.   

 
   Class B low flow.  Class B low flow can exist for either subcritical or 

supercritical profiles.  For either profile, class B flow occurs when the profile 
passes through critical depth in the bridge constriction.  For a subcritical 
profile, the momentum equation is used to compute an upstream water 
surface above critical depth and a downstream water surface below critical 
depth, using a momentum balance through the bridge.  For a supercritical 
profile, the bridge is acting as a control and is causing the upstream water 
surface elevation to be above critical depth.  Momentum is used again to 
calculate an upstream water surface above critical depth and a downstream 
water surface below critical depth.  The program will proceed with forewater 
calculations downstream from the bridge. 

 
   Class C low flow.  Class C low flow exists when the water surface through 

the bridge is completely supercritical.  The program can use either the energy 
or the momentum equation to compute the water surface through the bridge. 

 

 6-27



Chapter 6  Entering and Editing Geometric Data 

   Pressure Flow Computations.  Pressure flow occurs when the flow comes 
into contact with the low chord of the bridge.  Once the flow comes into 
contact with the upstream side of the bridge, a backwater occurs and orifice 
flow is established.  The program will handle two cases of orifice flow: the 
first is when only the upstream side of the bridge is in contact with the water; 
and the second is when the bridge constriction is flowing completely full.  For 
the first case, a sluice gate type of equation is used, as described in 
"Hydraulics of Bridge Waterways" (FHWA, 1978).  In the second case, the 
standard full flowing orifice equation is used.  The program will begin 
checking for the possibility of pressure flow when the energy grade line goes 
above the maximum low chord elevation.  Once pressure flow is computed, 
the pressure flow answer is compared to the low flow answer and the higher 
of the two is used.  The user has the option to tell the program to use the 
water surface, instead of energy, to trigger the pressure flow calculation. 

 
   Weir Flow Computations.  Flow over the bridge and the roadway 

approaching the bridge will be calculated using the standard weir equation.  
For high tailwater elevations the program will automatically reduce the 
amount of weir flow to account for submergence on the weir.  This is 
accomplished by reducing the weir coefficient based on the amount of 
submergence.  When the weir becomes highly submerged, the program will 
automatically switch to calculating losses based on the energy equation 
(standard step backwater).  The criteria for when the program switches to 
energy based calculations is user controllable.  

 
   Combination Flow.  Sometimes combinations of low flow or pressure flow 

occur with weir flow.  In these cases an iterative procedure is used to 
determine the amount of each type of flow.   

 
   Entering and Editing Bridge Data 
 
   To enter bridge data the user presses the Bridge/Culvert button on the 

geometric data window (Figure 6.1).  Once the bridge/culvert button is 
pressed, the Bridge/Culvert Data Editor will appear as shown in Figure 6.12 
(your bridge/culvert editor will come up with a blank window until you have 
entered the bridge data).  To add a bridge to the model, do the following: 

 
   1. Select the river and reach that you would like to place the bridge in.  

Selecting a reach is accomplished by pressing the down arrow on the 
river and reach box, then selecting the river and reach of choice. 

 
   2. Go to the Options menu and select Add a Bridge and/or Culvert 

from the list.  An input box will appear prompting you to enter a river 
station identifier for the new bridge.  

 
   3. Enter all of the required data for the new bridge.  This includes: 
    - Bridge Deck 
    - Sloping Abutments (optional) 
    - Piers (optional) 
    - Bridge modeling approach information 

 6-28



Chapter 6  Entering and Editing Geometric Data 

   4. Enter any desired optional information.  Optional bridge information 
is found under the Options menu at the top of the window. 

 
   5. Press the Apply Data button for the interface to accept the data. 
 

 
 
   Figure 6.12  Bridge/Culvert Data Editor 
 
 
   The required information for a bridge consists of: the river, reach, and river 

station identifiers; a short description of the bridge; the bridge deck; bridge 
abutments (if they exist); bridge piers (if the bridge has piers); and specifying 
the bridge modeling approach.  A description of this information follows: 

 
   River, Reach and River Station.  The River and Reach boxes allow the user 

to select a river and reach from the available reaches that are defined in the 
schematic diagram.  The reach label defines which reach the bridge will be 
located in.  The River Station tag defines where the bridge will be located 
within the specified reach.  The river station tag does not have to be the actual 
river station of the bridge, but it must be a numeric value.  The river station 
tag for the bridge should be numerically between the two cross sections that 
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bound the bridge.  Once the user selects Add a Bridge and/or Culvert from 
the options menu, an input box will appear prompting you to enter a river 
station tag for the new bridge.  After the river station tag is entered, the two 
cross sections that bound the bridge will be displayed on the editor. 

 
   Description.  The description box is used to describe the bridge location in 

more detail than just the reach and river station.  This box has a limit of 256 
characters.  Only the first line of information is displayed, unless the button to 
the right of the box is pressed.  Also, the first 40 characters of the description 
are used as a label for bridge plots and tables.   

 
   Bridge Deck/Roadway.  The bridge deck editor is used to describe the area 

that will be blocked out due to the bridge deck, road embankment and vertical 
abutments.  To enter bridge deck information the user presses the Deck 
button on the Bridge/Culvert Data Editor.  Once the deck button is pressed, 
the Deck Editor will appear as in Figure 6.13 (except yours will be blank).  
The information entered in the deck editor consists of the following:   

 

 
  Figure 6.13  Bridge Deck/Roadway Data Editor 

 
 
   Distance - The distance field is used to enter the distance between the 

upstream side of the bridge deck and the cross section immediately upstream 
of the bridge (see Figure 6.14, “Upstream Distance”).  This distance is 
entered in feet (or meters for metric). 
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   Width - The width field is used to enter the width of the bridge deck along the 
stream (Figure 6.14, “Bridge Width”).  The distance between the bridge deck 
and the downstream bounding cross section will equal the main channel reach 
length minus the sum of the bridge "width" and the "distance" between the 
bridge and the upstream section.  The width of the bridge deck should be 
entered in feet (meters for metric). 

 

3 2 BU BD 

Upstream 
Distance 

Bridge 
Width 

Dow nstream 
Distance 

 
 
   Figure 6.14  Bridge Profile With Upstream Distance, Bridge Width, and 

Downstream Distance. 
 
   Weir Coefficient - Coefficient that will be used for weir flow over the bridge 

deck in the standard weir equation.  
 
   Upstream Stationing, High Chord, and Low Chord - This table is used to 

define the geometry of the bridge deck on the upstream side of the bridge.  
The information is entered from left to right in cross section stationing.  The 
deck is the area between the high and low chord elevation information.  The 
stationing of the deck does not have to equal the stations in the bounding 
cross section, but it must be based on the same origin.  The Del Row and Ins 
Row buttons allow the user to delete and insert rows. 

 
   Downstream Stationing, High Chord, and Low Chord - This portion of the 

table is used to define the geometry of the bridge deck on the downstream 
side of the bridge.  If the geometry of the downstream side is the same as the 
upstream side, then the user only needs to press the Copy Up to Down 
button.  When this button is pressed, all of the upstream bridge deck 
information is copied to the downstream side.  If the bridge deck information 
on the downstream side is different than the upstream side, then the user must 
enter the information into the table. 

 
   U.S. Embankment SS - This field is used to enter the slope of the road 

embankment on the upstream side of the bridge.  The slope should be entered 
as the horizontal to vertical distance ratio of the embankment.  This variable 
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is generally not used in the computations, but is used for display purposes in 
the profile plot.  However, if the user has selected the FHWA WSPRO bridge 
method for low flow, this field will be used in the computation of the bridge 
discharge coefficient. 

 
   D.S. Embankment SS - This field is used to enter the slope of the road 

embankment on the downstream side of the bridge.  The slope should be 
entered as the horizontal to vertical distance ratio of the embankment.  This 
variable is generally not used in the computations, but is used for display 
purposes in the profile plot.  However, if the user has selected the FHWA 
WSPRO bridge method for low flow, this field will be used in the 
computation of the bridge discharge coefficient. 

 
   Max Allowable Submergence - The maximum allowable submergence ratio 

that can occur during weir flow calculations over the bridge deck.  If this ratio 
is exceeded, the program automatically switches to energy based calculations 
rather than pressure and weir flow.  The default value is 0.95 (95 percent 
submerged). 

 
   Submergence Criteria - When submergence occurs there are two choices 

available to figure out how much the weir coefficient should be reduced due 
to the submergence.  The first method is based on work that was done on a 
trapezoidal shaped broad crested weir (FHWA, 1978).  The second criterion 
was developed for an Ogee spillway shape (COE,1965).  The user should 
pick the criterion that best matches their problem. 

 
   Min Weir Flow El - This field is used to set the minimum elevation for which 

weir flow will begin to be evaluated.  Once the computed upstream energy 
becomes higher than this elevation, the program begins to calculate weir flow.  
However, the weir flow calculations are still based on the actual geometry of 
the deck/roadway, and are not effected by this elevation.  If this field is left 
blank, the elevation that triggers weir flow is based on the lowest high chord 
elevation on the upstream side of the bridge deck.  Also, weir flow is based 
on the elevation of the energy grade line and not the water surface. 

 
   Once all of the bridge deck information is entered, the user should press the 

OK button at the bottom of the window.  Pressing the OK button tells the 
interface to accept the data and close the window.  Once the deck editor 
closes, the graphic of the bridge deck will appear on the Bridge/Culvert Data 
window.  An example of this is shown in Figure 6.15.  Note!  The data are 
not saved to the hard disk at this point.  Geometric data can only be saved 
to the hard disk from the File menu of the Geometric Data window.   
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   Figure 6.15  Example Bridge Deck Plotted on Bounding Cross Sections 
 
 
   Sloping Bridge Abutments.  The sloping bridge abutments editor is used to 

supplement the bridge deck information.  Whenever bridge abutments are 
protruding towards the main channel (sloping inward abutments), it will be 
necessary to block out additional area that cannot be accounted for in the 
bridge deck/roadway editor.  If the bridge has vertical wall abutments, then it 
is not necessary to use this editor.  Vertical wall abutments can be included as 
part of the bridge deck/roadway data.  To add sloping abutments, the user 
presses the Sloping Abutment button on the Bridge/Culvert Data editor.  
Once this button is pressed the Abutment data editor will appear as in Figure 
6.16.   

 
   Sloping abutments are entered in a similar manner to the bridge 

deck/roadway.  When the editor is open, it has already established an 
abutment # of 1.  Generally a left and right abutment are entered for each 
bridge opening.  Sloping abutment data are entered from left to right, looking 
in the downstream direction.  In general it is usually only necessary to enter 
two points to describe each abutment. 
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   Figure 6.16  Abutment Data editor  
 
    
   The data for each abutment consist of a skew angle (this is optional) and the 

station and elevation information.  The station and elevation information 
represents the high chord information of the abutment.  The low chord 
information of the abutment is assumed to be below the ground, and it is 
therefore not necessary to enter it.  The geometric information for each 
abutment can vary from upstream to downstream.  If this information is the 
same, then the user only needs to enter the upstream geometry and then press 
the Copy Up to Down button.   

 
   To add additional sloping abutments, the user can either press the ADD or the 

Copy button.  To delete an abutment, press the Delete button.  Once all of the 
abutment data are entered, the user should press the OK button.  When the 
OK button is pressed, the abutment information is accepted and the editor is 
closed.  The abutments are then added to the bridge graphic on the 
Bridge/Culvert Data editor.  An example of a sloping bridge abutment is 
shown in Figure 6.17.  This graphic is zoomed in on the left abutment of the 
bridge. 
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  Figure 6.17  Example of a Sloping Abutment 
 
    
   Bridge Piers.  The bridge pier editor is used to describe any piers that exist in 

the bridge opening.  Note!  All piers must be entered through the Pier 
Editor, they should not be included as part of the ground or bridge deck.  
Several of the low flow bridge computations require that the piers be defined 
separately in order to determine that amount of area under the water surface 
that is blocked by the piers.  If the piers are included with the ground or the 
bridge deck, several of the methods will not compute the correct amount of 
energy loss for the piers. 
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   To enter pier information, the user presses the Pier button on the 
Bridge/Culvert Data editor.  Once the pier button is pressed, the pier data 
editor will appear as in Figure 6.18 (except yours will not have any data in it 
yet). 

 

 
 
   Figure 6.18  Pier Data Editor 
 
 
   When the pier data editor appears it will have already defined the first pier as 

pier # 1.  The user is required to enter a centerline station for both the 
upstream and downstream side of the pier.  The skew angle is entered in 
degrees that the pier is skewed from a line parallel to the flow.  The skew 
angle is an optional item.  The pier geometry is entered as pier widths and 
elevations.  The elevations must start at the lowest value and go to the highest 
value.  Generally the elevations should start below the ground level.  Any pier 
area below the ground will be clipped off automatically.  Pier widths that 
change at a single elevation are handled by entering two widths at the same 
elevation.  The order of the widths in the table is very important.  Keep in 
mind that the pier is defined from the ground up to the deck.  If the pier 
geometry on the downstream side is the same as the upstream side, simply 
press the Copy Up to Down button after the upstream side data are entered. 
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   The user also has the option of defining floating pier debris.  If the Floating 
Debris option is selected, the user will need to enter a width and a height for 
the debris.  The user can set a different height and width of debris for each 
pier, or there is a button that will allow the user to enter a single height and 
width that will be used for all of the piers. 

 
   Additional piers can be added by pressing either the Add or the Copy button.  

If the piers are the same shape, it is easier to use the copy button and simply 
change the centerline stations of the new pier.  To delete a pier, simply press 
the Delete button and the currently displayed pier will be deleted.  Once all of 
the pier data are entered, press the OK button.  When the OK button is 
pressed, the data will be accepted and the pier editor will be closed.  The 
graphic of the bridge will then be updated to include the piers.  An example 
bridge with piers is shown in Figure 6.19.  This graphic is only the upstream 
side of the bridge with a zoomed in view.    

 

 
 

  Figure 6.19  Bridge with Piers, zoomed in view 
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   Bridge Modeling Approach.  The Bridge Modeling Approach editor is used 
to define how the bridge will be modeled and to enter any coefficients that are 
necessary.  To bring up the Bridge Modeling Approach editor press the 
Bridge Modeling Approach button on the Bridge/Culvert Data editor.  Once 
this button is pressed, the editor will appear as shown in Figure 6.20 (except 
yours will only have the default methods selected). 

 

    
 
   Figure 6.20  Bridge Modeling Approach Editor 
 
 
    
   When the Bridge Modeling Approach editor comes up it will be ready to 

enter data for the first bridge opening (coefficient set # 1).  If there is more 
than one bridge opening at the current location, the user can either use a 
single set of modeling approaches and coefficients, or establish a different set 
for each bridge opening.   

 
   Establishing a bridge modeling approach consists of defining which methods 

the program will use for low flow computations and high flow (flow at or 
above the maximum low chord) computations.  The user can instruct the 
program to use any or all of the low flow methods during the computations by 
clicking the buttons under the Compute column.  If either the Momentum or 
Yarnell method are selected, the user must enter a value for the pier loss 
coefficient that corresponds to that method.  If the WSPRO method is 
selected, the user must press the "WSPRO Variables" button and enter 
additional information that is required for the method.  Once the WSPRO 
Variables button is pressed, a data editor as shown in Figure 6.21 will 
appear. 

 6-38



Chapter 6  Entering and Editing Geometric Data 

 
 
   Figure 6.21  WSPRO Data Editor 
 
 
   As shown in Figure 6.21, there are several variables that must be entered as 

well as some options that are available to the user.  All of the required 
variables shown on the WSPRO data editor are used in the computation of the 
discharge coefficient, C, which is used in the WSPRO expansion loss 
equation.  A detailed discussion of how the discharge coefficient is computed 
can be found in appendix D of the HEC-RAS Hydraulic Reference manual.  
The following is a description of each of the variables on the WSPRO Data 
Editor: 

 
   El of the top of the Embankment - These fields are used for entering the 

elevation of the top of the embankment (top of road) at the edges of the 
bridge opening.  An elevation must be entered for both the left and right side 
of the bridge opening.   

 
   El of the toe of the Abutment - These fields are used for entering the elevation 

of the abutment toe (elevation at the station in which the abutment toe 
intersects with the natural ground inside the bridge opening) on both the left 
and right side of the bridge opening. 

 
   Abutment Type - This field is used for selecting the type of abutments.  There 

are four abutment types available from this selection box. 
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   Slope of the Abutments - This field is used for entering the slope of the 
abutments.  This slope is taken as the horizontal distance divided by the 
vertical distance.  If the abutments are vertical walls, then this field should be 
left blank or set to zero.  If the left and right abutments do not have the same 
slope, take an average of the two and enter that into this field. 

 
   Top Width of Embankment - This field is used for entering the width of the 

top of the road embankment, in the area of the bridge opening.  If the 
topwidth of the embankment varies from one end of the bridge opening to the 
other, use an average of the two widths. 

 
   Centroid stationing of the projected bridge opening at the approach cross 

section - For the WSPRO bridge method, it is necessary to calculate the water 
surface topwidth inside of the bridge opening, and then project that width 
onto the approach cross section.  The program calculates the conveyance 
within this projected width at the approach cross section.  This conveyance is 
used in calculating a channel contraction ratio, which is an integral part in the 
calculation of the discharge coefficient.  If this field is left blank, the program 
will automatically center the computed topwidth, such that the center of the 
topwidth will be at the center of conveyance at the approach cross-section.  
The user can override this by entering their own centroid stationing value for 
the approach cross section. 

 
   Wing Walls - This field is used for selecting the type of wing walls.  There are 

three choices available in the selection box: No wing walls present; Angular 
wing walls; and Rounded wing walls.  If the user selects "Angular wing 
walls", then the fields labeled "Angle of Wing Wall" and "Length of Wing 
Wall" become active and must be filled out.  If the user selects "Rounded 
wing walls", then the fields "Length of wing walls" and "Radius of entrance 
rounding" become active and must be filled out.  If the user selects "No wing 
walls present" then no other information on wing walls is necessary.  For 
more information on wing walls see appendix D of the HEC-RAS Hydraulic 
Reference manual. 

 
   Guide Banks Type - This field is used for selecting the type of guide banks if 

any exist.  There are three choices available from the selection box: No guide 
bank present; Straight; and Elliptical.  If the user selects "Straight" then the 
fields labeled "Length of guide banks", "Offset of Guide Banks", and "Skew 
of Guide Banks" become active and must be filled out.  If the use selects 
"Elliptical" then only the fields "Length of Guide Banks" and "Offset of 
Guide Banks" become active.  If the user selects "No Guide Bank present" 
then no other information about guide banks is necessary.  For more 
information on Guide Banks see appendix D of the HEC-RAS Hydraulic 
Reference manual. 
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   Optional Contraction and Expansion Losses - This box allows the user to turn 
on contraction and expansion losses at locations that are traditionally not in 
the WSPRO methodology.  The basic WSPRO bridge method only computes 
expansion losses in the expansion reach (between the exit cross section and 
the section just downstream of the bridge).  This option allows the user to turn 
on contraction and expansion losses individually at the following locations: 
downstream inside of the bridge; upstream inside of the bridge; upstream 
outside of the bridge; at the end of a guide bank (if guide banks exist); and at 
the approach cross section.  The default for the WSPRO method is that 
contraction and expansion losses will not be calculated at these locations.  
Users should not turn these options on unless they feel that the standard 
WSPRO bridge approach is not producing enough energy loss through the 
bridge. 

 
   Two other options that the user has control over are: specifying that the piers 

are continuous the whole way through the bridge or not, and using the 
Geometric Mean friction slope averaging technique through the bridge 
computations (from exit to approach section).  The default for the WSPRO 
methodology is to assume that the piers are continuous through the bridge, 
and to use the Geometric Mean friction slope method. 

 
   After all of the variables have been entered, the user must press the OK 

button for the WSPRO variables to be accepted.  For more information about 
the computation of the discharge coefficient, and these data variable, see 
appendix D of the HEC-RAS Hydraulic Reference manual. 

 
   Once the user has selected which low flow bridge methods will be computed, 

they must also specify which of those methods will be used as the final 
answer to continue the computations on upstream with.  Only one of the 
methods can be selected as the answer to "Use" in order to continue the 
computations upstream.  An alternative to selecting a single method to use is 
to instruct the program to use the answer with the highest computed upstream 
energy elevation.  This is accomplished by pressing the button under the 
"Use" column that corresponds to the Highest Energy Answer text field.   

 
   For high flows, the modeler can choose between Energy based calculations or 

pressure and weir flow calculations.  If pressure and weir flow is the selected 
high flow method, the user must enter coefficients for the pressure flow 
equations.  The first coefficient applies to the equation that is used when only 
the upstream side (inlet) of the bridge is submerged.  If this coefficient is left 
blank, the program selects a coefficient based on the amount of submergence.  
If the user enters a coefficient, then that value is used for all degrees of 
submergence.  The second coefficient applies to the equation that is used 
when both the upstream and downstream end of the bridge is sub-merged.  
Generally this coefficient is around 0.8.  For more information on pressure 
flow coefficients see Hydraulics of Bridge Waterways (FHWA, 1978). 

 
   Max Low Chord - This field is used to set the maximum elevation of the deck 

low chord, and therefore the elevation at which pressure flow begins to be 
calculated.  If this field is left blank, then the elevation that triggers pressure 
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flow calculations is based on the highest low chord elevation on the upstream 
side of the bridge deck.  If the user enters a value in this field, then the value 
set will be used to trigger when pressure flow calculations begin.  Pressure 
flow is triggered when the energy elevation exceeds the maximum low chord.  
When pressure flow is calculated, the answer is compared to the low flow 
answer and the higher of the two is selected.  Alternatively, the user can tell 
the program to use the water surface instead of the energy elevation to trigger 
pressure flow calculations.  This option can be found under the Bridge and 
Culvert Options section of this manual. 

 
   Once all of the bridge modeling approach information is entered, the user 

should press the OK button.  When the OK button is pressed the information 
will be accepted and the editor will close.  Remember!  The data are not 
saved to disk at this point, it is only accepted as being valid.  To save the 
geometric data, use the File menu from the Geometric Data Editor window. 

    
   Bridge Design Editor 
 
   The bridge design editor allows the user to enter or modify bridge data 

quickly and conveniently.  With this editor the user can enter the 
deck/roadway data, sloping abutments, and pier information.  To put together 
a bridge with this editor, the user would do the following: 

 
 1. From the Geometric Data window, open the Bridge/Culvert data 

editor.  Select the River and Reach in which you would like to place 
the bridge. 

 
2. Go to the Options menu and select Add a Bridge and/or Culvert 

from the list.  An input box will appear prompting you to enter a river 
station identifier for the new bridge. 

 
3. Open the Bridge Design editor by pressing the Bridge Design button 

on the lower left side of the Bridge/Culvert Data editor. 
 

4. Enter the required data for the bridge deck/roadway, sloping 
abutments (optional), and piers (optional). 

 
   When the Bridge Design button is pressed, a window will appear as shown in 

Figure 6.22.  The user only has to enter a minimal amount of information to 
build or edit the bridge.  To create the bridge deck/roadway, the user must 
enter a high cord elevation (top of road) and a low cord elevation (maximum 
elevation inside of the bridge opening).   
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   Figure 6.22  Bridge Design Editor 
 
 
   The user has the option to limit the width of the bridge opening by selecting 

the Add Vertical Walls in Deck option.  When this option is selected, the 
bridge opening will be limited to either the main channel bank stations (this is 
the default) or a user specified width (this is optional).  Everything left and 
right of the bridge opening will be completely filled in all the way to the 
ground elevations.  If the user enters a bridge opening width, the opening will 
be centered between the main channel bank stations. 

 
   The user also has the option to enter sloping abutments.  Sloping abutments 

should only be entered after selecting to limit the width of the bridge opening 
with the vertical walls option.  To enter sloping abutments, the user only has 
to enter a slope in units of horizontal to vertical.  The program will 
automatically build a left and right sloping abutment that starts in the upper 
left and right corners of the bridge opening. 

           
   Once all of the bridge deck/roadway information is entered, the user can have 

the program build the deck/roadway by pressing the Make Deck/Roadway 
button. 

 
   The last option available in the Bridge Design editor is to enter pier 

information.  The user enters the number of piers, the upstream and 
downstream stationing of the left most pier, the spacing between the 
centerline of the piers, and the width of the piers.  The user then presses the 
Make Piers button to have the interface build the piers. 
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   After all of the bridge data are entered, the user presses the Close button to 
get out of the editor.  The bridge data can be changed at any time by either 
going back into the Bridge Design editor and entering new values, or by 
going to the more detailed editors for the bridge deck/roadway, sloping 
abutments, and piers. 

 
 
   Culvert Hydraulic Computations 
 
   The culvert hydraulic computations in HEC-RAS are similar to the bridge 

hydraulic computations, except the Federal Highway Administration's 
(FHWA) standard equations for culvert hydraulics under inlet control are 
used to compute the losses through the structure.  Because of the similarities 
between culverts and other types of bridges, the cross section layout, the use 
of ineffective areas, the selection of contraction and expansion coefficients, 
and many other aspects of bridge analysis apply to culverts as well. 

 
   The culvert routines in HEC-RAS have the ability to model nine different 

types of culvert shapes.  These shapes include box (rectangular), circular, 
elliptical, arch, pipe arch, semi circular, low profile arch, high profile arch, 
and Con Span culverts.  

 
   The analysis of flow in culverts is complicated.  It is common to use the 

concepts of "Inlet" control and "Outlet" control to simplify the analysis.  Inlet 
control flow occurs when the flow carrying capacity of the culvert entrance is 
less than the flow capacity of the culvert barrel.  Outlet control flow occurs 
when the culvert carrying capacity is limited by downstream conditions or by 
the flow capacity of the culvert barrel.  The HEC-RAS culvert routines 
compute the headwater required to produce a given flow rate through the 
culvert for inlet control conditions and for outlet control conditions.  In 
general, the higher headwater "controls," and an upstream water surface is 
computed to correspond to that energy elevation. 

 
   Inlet Control Computations.  For inlet control, the required headwater is 

computed by assuming that the culvert inlet acts as an orifice or a weir.  
Therefore, the inlet control capacity depends primarily on the geometry of the 
culvert entrance.  Extensive laboratory tests by the National Bureau of 
Standards, and the Bureau of Public Roads (now, FHWA), and other entities 
resulted in a series of equations which describe the inlet control headwater 
under various conditions.  These equations are used by HEC-RAS in 
computing the headwater associated with inlet control. 

 
   Outlet Control Computations.  For outlet control flow, the required 

headwater must be computed considering several conditions within the 
culvert and the downstream tailwater.  For culverts flowing full, the total 
energy loss through the culvert is computed as the sum of friction losses, 
entrance losses, and exit losses.  Friction losses are based on Manning's 
equation.  Entrance losses are computed as a coefficient times the velocity 
head in the culvert at the upstream end.  Exit losses are computed as a 
coefficient times the change in velocity head from just inside the culvert (at 
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the downstream end) to outside the culvert. 
 
   When the culvert is not flowing full, the direct step backwater procedure is 

used to calculate the profile through the culvert up to the culvert inlet.  An 
entrance loss is then computed and added to the energy inside the culvert (at 
the upstream end) to obtain the upstream energy (headwater).  For more 
information on the hydraulics of culverts, the reader is referred to Chapter 6 
of the HEC-RAS Hydraulics Reference manual. 

 
 
   Entering and Editing Culvert Data 
 
   Culvert data are entered in the same manner as bridge data.  To enter culvert 

data the user presses the Bridge/Culvert button on the Geometric Data 
window (Figure 6.1).  Once this button is pressed, the Bridge/Culvert Data 
Editor will appear (Figure 6.12).  To add a culvert group to the model the user 
must then do the following: 

 
   1. Select the river and reach that you would like to place the culvert in.  

This selection is accomplished by pressing the down arrow on the 
river and reach boxes and then selecting the river and reach of choice. 

 
   2. Go to the Options menu of the Bridge/Culvert editor and select Add 

a Bridge and/or Culvert from the list.  An input box will appear 
prompting you to enter a river station identifier for the new culvert 
group.  After entering the river station, press the OK button and the 
cross sections that bound the new culvert group will appear in the 
editor. 

 
   3. Enter all of the required data for the culvert group.  This includes the 

road embankment information and the culvert specific data.  The 
roadway information is entered in the same manner as a bridge (using 
the deck/roadway editor).  To enter culvert specific data, press the 
Culvert button on the Bridge/Culvert Data editor. 

 
 
   4. Once all of the culvert data are entered, press the OK button in order 

for the interface to accept the information. 
 
 
   River, Reach and River Station.  The River and Reach boxes allow the user 

to select a river and reach from the available reaches that were put together in 
the schematic diagram.  The reach label defines which reach the culvert will 
be located in.  The River Station tag defines where the culvert will be located 
within the specified reach.  The River Station tag does not have to be the 
actual river station of the culvert, but it must be a numeric value.  The River 
Station tag for the culvert should be numerically between the two cross 
sections that bound the culvert.  Once the user selects Add a Bridge and/or 
Culvert from the options menu, an input box will appear prompting you to 
enter a River Station tag for the new culvert.  After the River Station tag is 
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entered, the two cross sections that bound the culvert will be displayed on the 
editor. 

 
   Description.  The description box is used to describe the culvert location in 

more detail than just the river, reach and river station.  This box has a limit of 
256 characters.  Only the first line of information is displayed, unless the 
button to the right of the box is pressed.  Also, the first 40 characters of the 
description are used as a label for culvert plots and tables. 

 
   Culvert Road Embankment.  The culvert road embankment is virtually the 

same as the bridge deck/roadway information.  The road embankment is used 
to describe the area blocking the stream and the roadway profile.  The only 
difference in the information for culverts is that the low chord elevations 
should be left blank or set to elevations below the ground data.  This will 
cause the road embankment to completely fill the channel up to the roadway 
elevations (high chord data).  Therefore, the only opening below the roadway 
will be whatever culvert openings are entered. 

 
   To enter the culvert roadway information, press the Deck/Roadway button on 

the Bridge/Culvert Data Editor window.  For an explanation of the deck 
information, please review the section entitled Bridge Deck/Roadway found 
earlier in this chapter. 

 
   Culvert Data.  To enter culvert specific information, press the Culvert 

button on the Bridge/Culvert Data Editor window.  When this button is 
pressed, the Culvert Data Editor will appear as shown in Figure 6.23 (except 
yours will be blank).  The information entered in the Culvert Data Editor 
consists of the following: 
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   Figure 6.23  Culvert Data Editor 
 
 
   Culvert ID# -  The culvert identifier (ID#) is automatically assigned to 

"Culvert #1" the first time you open the editor.  The user can enter up to ten 
culvert types if they are working on a multiple culvert, opening problem.   If 
all of the culvert barrels are exactly the same, then only one culvert type 
(Culvert ID#) should be entered.  The number of barrels is an input parameter 
in the culvert data.  If the user has culverts that are different in shape, size, 
elevation, or loss coefficients, then additional culverts types (Culvert ID#'s) 
must be added for each culvert type.  To add an additional culvert type you 
can either use the Add or Copy buttons.  The Add button increments the 
culvert ID# and clears the culvert editor.  The Copy button increments the 
culvert ID# and makes a copy of the original culvert data.  Once a copy is 
made of a culvert, the user can change any of the existing culvert information.  
Culverts can be deleted by pressing the Delete button. 

 
   Solution Criteria - This option allows the user to select between taking the 

higher of the inlet control and outlet control answers (Highest U.S. EG), or 
specifically selecting the Inlet control or Outlet control answer.  The default is 
to let the program compute both and take the higher of the two.  In general 
this should be left this way.  The only time a user should specifically select 
Inlet control or Outlet control, is when they feel the program is in error by 
selecting the higher of the two answers. 
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   Rename - This button allows the user to put in their own identifier for each of 
the culvert types.  By default the culvert types will be labeled "Culvert #1," 
"Culvert #2," and so on.  The user can enter up to twelve characters for each 
culvert type. 

 
   Shape - The shape selection box allows the user to select from one of the nine 

available shapes.  This selection is accomplished by pressing the down arrow 
on the side of the box, then selecting one of the nine available shapes. 

 
   Span - The span field is used to define the maximum width inside of the 

culvert.  The span is left blank for circular culverts. 
 
   Rise - The rise field describes the maximum height inside of the culvert. 
 
   Chart #. - This field is used to select the Federal Highway Administration 

Chart number that corresponds to the type and shape of culvert being 
modeled.  Once the user has selected a culvert shape, the corresponding 
FHWA chart numbers will show up in the chart # selection box.  More 
information on FHWA chart numbers can be found in the Hydraulics 
Reference manual. 

 
   Scale. -  This field is used to select the Federal Highway Administration Scale 

number that corresponds to the type of culvert entrance.  Once the user has 
selected a culvert shape and chart #, the corresponding FHWA scale numbers 
will show up in the scale selection box.  More information on FHWA scale 
numbers can be found in the Hydraulics Reference manual. 

 
   Distance to Upstream XS - This field is used to locate the culvert in space, 

relative to the two cross sections that bound the culvert crossing.  The user 
should enter the distance between the upstream cross section and the 
upstream end of the culvert barrel. 

 
   Culvert Length - The culvert length field describes the length of the culvert 

along the centerline of the barrel. 
 
   Entrance Loss Coefficient - The coefficient entered in this field will be 

multiplied by the velocity head inside of the culvert at the upstream end.  This 
value represents the amount of energy loss that occurs as flow transitions 
from the upstream cross section to inside the culvert barrel.  This coefficient 
is used in the outlet control computations. 

 
   Exit Loss Coefficient - The coefficient entered in this field will be multiplied 

by the change in velocity head from inside the culvert to outside the culvert at 
the downstream end.  This value represents the energy loss that occurs as 
water exits the culvert.  This coefficient is used in the outlet control 
computations. 

 
   Manning’s n for Top - The n-value fields are used for entering the Manning's 

n values of the culvert barrel.  This version of HEC-RAS allows the user to 
enter a separate n value for the top (which includes top and sides) of the 
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culvert, as well as for the bottom.  If the culvert has the same roughness for 
the top and bottom, the user can enter the value for the top.  The Manning’s n 
value for the bottom will automatically be copied from the top field. 

 
   Manning’s n for Bottom – This field is used to enter a Manning’s n value for 

the bottom of the culvert.  This n value will be used up to a user specified 
depth inside of the culvert.  When the water surface gets higher than that 
depth, a composite Manning’s n value is computed based on the bottom and 
top n values and their corresponding wetted perimeters. 

 
   Depth to use Bottom n – This field is used to specify the depth that the 

“Bottom n value” is applied inside of the culvert.  The surface of the culvert 
below this depth is given the n value for the bottom of the culvert, while the 
surface of the culvert above this depth is given the n value for the top of the 
culvert. 

 
   Depth Blocked – This field is used to block off a portion of the bottom of the 

culvert.  When a value is entered into this field, the culvert is completely 
blocked up to the depth specified.  This blocked out area persists the whole 
way through the culvert. 

 
   Upstream Invert Elevation - This field is used to describe the elevation of the 

culvert invert at the upstream end.   
 
   Downstream Invert Elevation - This field is used to describe the elevation of 

the culvert invert at the downstream end. 
 
   # Identical Barrels - This field is used to display the number of identical 

barrels.  The number of identical barrels is limited to 25.  To enter more than 
one identical barrel, the user must provide different centerline stationing 
information for each barrel.  As the centerline stationing information is added, 
the number of identical barrels will automatically change to reflect the 
number of centerline stations.  The user does not enter anything into this field, 
it is just used to display the number of identical barrels. 

 
   Centerline Stations - This table is used to enter the stationing of each culvert 

barrel.  Centerline stations must be provided for both the upstream and 
downstream side of each culvert barrel. 

 
   Once all of the culvert information is entered, the user should press the OK 

button at the bottom of the window.  Pressing the OK button tells the 
interface to accept the data and close the window.  Once the culvert editor is 
closed, the graphic of the culvert will appear on the Bridge/Culvert Data 
editor window.  An example culvert with two culvert types and two identical 
barrels for each culvert type is shown in Figure 6.24.  Note!  The data are 
not saved to the hard disk at this point.  Geometric data can only be saved 
from the File menu on the Geometric Data window. 

 
 
 

 6-49



Chapter 6  Entering and Editing Geometric Data 

 
 
   Figure 6.24  Bridge/Culvert Data Editor with example culvert 
 
 
   Bridge and Culvert Options 
 
   Some additional options that are available, but not required, are found under 

the Options menu from the Bridge/Culvert Data Editor.  These include the 
following: 

 
   Add a Bridge and/or Culvert.  This option initiates the process of adding a 

bridge or culvert to the data set.  The user is prompted to enter a river station 
tag for the new bridge or culvert.  The river station tag locates the bridge or 
culvert within the selected reach.  Once the river station is entered, the 
Bridge/Culvert Data editor is cleared and the user can begin entering the data 
for that new bridge or culvert. 

 
   Copy Bridge and/or Culvert.  This option allows the user to make a copy of 

the bridge and/or culvert crossing and place it in another reach and/or river 
station within the current project. 
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   Rename River Station.  This option allows the user to change the river 
station of the currently opened Bridge and/or Culvert crossing. 

 
   Delete Bridge and/or Culvert.  This option will delete the currently 

displayed bridge or culvert.  The user is prompted with a message stating 
specifically which bridge or culvert is going to be deleted, and requesting 
them to press the OK button or the Cancel button. 

 
   Internal Bridge Cross-Sections.  This option allows the user to edit the two 

cross sections inside of a bridge.  These two cross sections are a copy of the 
cross sections just upstream and downstream of the bridge.  If the ground 
elevations inside of the bridge are different than just outside of the bridge, 
then the internal bridge cross sections should be modified to reflect the 
changing elevations.  This option allows the user to change the station and 
elevation data, roughness coefficients, and main channel bank stations for 
each of the two internal bridge cross sections. 

 
   Momentum Equation.  This option allows the user to change the 

components of the momentum equation.  The momentum equation is one of 
the optional low flow methods in the bridge routines.  The default momentum 
equation includes terms in the equation to account for friction losses and the 
weight of water component.  The user can turn either or both of these 
components off from this option. 

 
   Momentum Class B Defaults.  If the program computes that the flow must 

pass through critical depth inside the bridge (Class B flow), critical depth will 
automatically be located inside the bridge at the most constricted cross 
section.  If both cross sections are identical, the program will locate critical 
depth at the upstream inside cross section.  This option allows the user to 
control where the program sets critical depth for class B flow.  If the user 
feels that it would be better to set critical depth inside the bridge at the 
downstream end, then this can be selected. 

 
   Pressure Flow Criteria.  This option allows the user to select either the 

energy grade line or the water surface, to be used as the criterion for when the 
program begins checking for the possibility of pressure flow.  By default the 
program uses the energy grade line.  This does not change how pressure flow 
is calculated, only when the program will begin checking for pressure flow. 

 
   Ice Option.  This option allows the user to select how ice will be handled 

inside of the bridge during ice computations.  This option is only pertinent if 
the user is performing a profile computation with the effects of ice included.  
When this option is selected, a window will appear asking the user to select 
one of three available options.  These options include:  no ice inside of the 
bridge; a constant amount of ice through the bridge; dynamic ice effects are to 
be computed through the bridge. 
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   Skew Bridge/Culvert.  This option allows the user to make adjustments to 
bridge/culvert data that is skewed (i.e. not perpendicular to the flow lines 
going through the bridge/culvert.  When this option is selected, a window will 
appear allowing the user to enter a skew angle for the deck/roadway, as well 
as the piers.  The stationing of the deck/roadway is reduced, by multiplying it 
by the cosine of the user entered skew angle.  Additionally, the user has the 
option to adjust the upstream and downstream cross sections bounding the 
bridge by the same skew angle.  A separate skew angle is entered for bridge 
piers.  The piers are assumed to go the whole way through the bridge as a 
single continuous pier.   

 
 
   Bridge and Culvert View Features 
 
   Several options are available for viewing the bridge/culvert geometric data.  

These options include: Zoom In; Zoom Out; Display Upstream XS; Display 
Downstream XS; Display Both; Highlight Weir, Opening Lid and Ground; 
Highlight Piers; and Grid.  These options are available from the View menu 
on the bridge/culvert data editor. 

 
   Zoom In.  This option allows the user to zoom in on a piece of the bridge or 

culvert.  This is accomplished by selecting Zoom In from the View menu, 
then specifying the area to zoom in on with the mouse.  Defining the zoom 
area is accomplished by placing the mouse pointer in the upper left corner of 
the desired area.  Then press down on the left mouse button and drag the 
mouse to define a box containing the desired zoom area.  Finally, release the 
left mouse button and the viewing area will display the zoomed in area of the 
bridge or culvert.  

 
   Zoom Out.  This option displays the bridge or culvert back into its original 

size before you zoomed in.  Zooming out is accomplished by selecting Zoom 
Out from the View menu bar on the bridge/culvert data editor. 

 
   Full Plot.  When this option is selected, the graphic is automatically redrawn 

back to its full extent, showing the entire bridge/culvert. 
 
   Pan.  When this option is selected, the user can move the zoomed in portion 

of the graphic.  This is accomplished by first selecting the Pan option, then 
pressing and holding down the left mouse button while over the graphic.  
Next, move the graphic in the desired direction, and then release the left 
mouse button.  The graphic will be redrawn with a new portion of the graphic 
shown in the zoomed in area. 

 
   Display Upstream XS.  When this option is selected, only the upstream side 

of the bridge or culvert will be displayed. 
 
   Display Downstream XS.  When this option is selected, only the 

downstream side of the bridge or culvert will be displayed. 
 
   Display Both.  When this option is selected, both the downstream and 
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upstream sides of the bridge will be displayed in the viewing area. 
 
   Highlight Weir, Opening Lid and Ground.  When this option is selected, 

various portions of the bridge/culvert graphic will be highlighted.  The 
program will highlight in red the combination of the deck/roadway high cord 
and any ground to the left and right of this data.  The red color shows what 
the program will use for weir flow if the Pressure and Weir option is selected 
for high flows. 

 
 The program will also highlight any bridge openings.  Within the bridge 

opening, the ground information will be highlighted in blue and the lid of the 
opening (deck/roadway low cord data) will be highlighted in green.  If the 
any of these three colors show up in an area where they should not be, then 
there must be a geometric mistake in the data.  This option is very useful for 
detecting any data entry errors that may otherwise go unnoticed. 

 
   Highlight Piers.  When this option is turned on the interface will highlight 

what it thinks is the extent of the pier information.  This option allows the 
user to see exactly what the program thinks piers are, and to see how the pier 
information has been clipped.  Piers are clipped below the ground and above 
the low chord of the bridge. 

 
   Grid.  This option allows the user to have a grid overlaid on top of the bridge 

or culvert graphic. 
 
 
Multiple Bridge and/or Culvert Openings 
 
   HEC-RAS has the ability to model multiple bridge and/or culvert openings at 

any individual river crossing.  Types of openings can consist of bridges, 
culvert groups (a group of culverts is considered to be a single opening), and 
conveyance areas (an area where water will flow as open channel flow, other 
than a bridge or culvert opening).  Up to seven openings can be modeled at a 
given location, and any combination of bridges and culvert groups can be 
used.  Conveyance type openings can range from zero to a maximum of two, 
and the conveyance areas must be located on the far left and far right of the 
river crossing. 

 
   An example multiple opening is shown in Figure 6.25.  As shown in this 

example, there are three types of openings: a conveyance area (left side, 
labeled as opening #1), a bridge (labeled as opening #2), and a culvert group 
(labeled as opening #3). During low flow conditions, flow will be limited to 
the bridge opening.  As flow increases, the culverts will begin to take some of 
the flow away from the bridge opening.  The conveyance area was defined as 
ineffective flow (no conveyance) until the water surface goes above the top of 
the bridge.  This was accomplished by setting blocked ineffective flow areas.  
In this example, three blocked ineffective flow areas were established:  one to 
the left of the bridge (which encompasses the whole conveyance area), one 
between the bridge and the culvert group, and one to the right of the culvert 
group.   
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   Figure 6.25  Example Multiple Opening River Crossing   
  
 
   Entering Multiple Opening Data 
    
   Multiple opening data are entered in the same manner as any other bridge or 

culvert crossing.  In general, the user should perform the following steps to 
enter multiple opening data: 

 
   1. Press the Bridge/Culvert button on the Geometric Data window. 
 
   2. Select the river and reach in which you would like to place the 

multiple opening river crossing.  This is accomplished from the River 
and Reach boxes near the top of the window. 

 
   3. Select Add a Bridge and/or Culvert from the Options menu of the 

bridge and culvert editor.  Enter the river station at which you want to 
place the multiple opening crossing.  Once you have done this, the 
two cross sections that bound this river station will appear in the 
window.  These two cross sections, along with the bridge and culvert 
information, will be used to formulate the two cross sections inside 
the multiple opening river crossing. 

 
   4. Enter the deck and road embankment data by using the 

Deck/Roadway editor. 
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   5. Enter any piers or sloping abutments that are required. 
 
   6. Select the Bridge Modeling Approach button and enter a set of 

coefficients and modeling approaches for each bridge opening.   
 
   7. Enter Culvert data for any culvert openings. 
 
   8. Select the Multiple Opening Analysis button on the bridge and 

culvert editor.  Enter the types of openings and their station limits.  
Start at the left most station of the crossing and work your way to the 
right end.  This is explained in greater detail under the section entitled 
"Defining the Openings".  

 
 
   Deck/Road Embankment Data.  There can only be one deck and road 

embankment entered for any bridge and/or culvert crossing.  The deck editor 
is used to describe the area that will be blocked out due to the bridge deck and 
road embankment.  As shown by the gray shaded area in Figure 6.25, the 
deck and roadway data are used to block out area around the bridge as well as 
around the culverts.  In the area of the bridge, high and low chord information 
is entered in order to define the top of road as well as the bridge opening.  In 
the area of the culverts, the high chord information is entered to define the 
rest of the top of the road embankment.  However, the low chord information 
can be left blank, or set to elevations below the ground, because the culvert 
data define the culvert openings. 

 
   Piers and abutments.  All piers are entered from the pier editor, which was 

described previously under bridge data.  The number of bridge openings has 
no impact on how pier data are entered.  Piers are treated as separate 
information.  Once the user establishes that there is more than one bridge 
opening, the program is smart enough to figure out which piers go with which 
opening.  If any sloping abutment data are required for a bridge opening, it 
can be entered as described previously under the bridge data section. 

 
   Bridge Modeling Approach.  A bridge modeling approach and coefficient 

set must be established for at least one bridge opening.  If there is more than 
one bridge opening, and the user has only established a single coefficient set 
and bridge modeling approach, those data will be used for all of the bridge 
openings.  The user can establish a different set of coefficients and modeling 
approaches for each bridge opening.  
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   Figure 6.26  Bridge Modeling Approach Editor 
 
 
 
   As shown in Figure 6.26, the user must enter information under the Bridge 

Modeling Approach editor for at least one bridge Opening.  Bridge openings 
are referred to as Bridge # 1, Bridge # 2, etc., up to the number of bridge 
openings.  Bridge # 1 represents the left most bridge opening while looking in 
the downstream direction.  Bridge # 2 represents the next bridge opening to 
the right of Bridge # 1, and so on.  The user can enter additional coefficient 
sets and modeling approaches by selecting either the Add or Copy button.  If 
either of these buttons is selected, the Bridge # will automatically be 
incremented by one.  The user can then enter or change any of the 
information on the editor for the second bridge opening. Any bridge opening 
that does not have a corresponding coefficient set and modeling approach, 
will automatically default to what is set for Bridge # 1. 

 
   Culvert Data.  Culvert information is added in the same manner as described 

in the previous section called "Entering and Editing Culvert Data."  Culverts 
will automatically be grouped based on their stationing.   
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   Defining The Openings 
 
   Once all of the bridge and/or culvert data are entered for a multiple opening 

river crossing, the last step is to define the number and type of openings that 
are being modeled.  This is accomplished by pressing the Multiple Opening 
Analysis button on the Bridge/Culvert Data editor.  Once this button is 
pressed, an editor will appear as shown in Figure 6.27 (except yours will be 
blank the first time you bring it up). 

 
 

 
 
   Figure 6.27  Multiple Opening Analysis window 
 
 
   The user selects from the three available opening types: Conveyance; Culvert 

Group; and Bridge.  Openings must be established in order from left to right, 
while looking in the downstream direction.  In addition to establishing the 
number and types of openings, the user must also enter a Station Left and a 
Station Right for each opening.  These stations are used to establish limits for 
each opening as well as stagnation points.  Stagnation points are the locations 
at which flow separates (on the upstream side) from one opening to the next 
adjacent opening.  Stagnation points can either be set to fixed locations or 
they can be allowed to migrate within limits.    

 
   As shown in Figure 6.27 (numerical representation) and Figure 6.25 

(graphical representation), there are three openings established in this 
example.  The first opening is defined as a conveyance area, and it ranges 
from station 98 (the left most station of the section) to station 260.  That 
means that any water in this area will be treated as normal open channel flow, 
and the water surface will be calculated by performing standard step 
calculations with the energy equation.  The second opening is the bridge 
opening.  This opening has a left station of 260 and a right station of 740.  
This bridge will be modeled by using the cross section data, bridge deck, and 
pier information that lie within these two stations (260 and 740).  The bridge 
coefficients and modeling approach for this opening will be based on the data 
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entered for bridge opening #1, since it is the first bridge opening.  The third 
opening is a culvert group.  This opening has a left station of 650 and a right 
station of 940.  Any culverts that lie within these stations will be considered 
as being in the same culvert group.   

 
   Notice that the right station of the bridge opening overlaps with the left 

station of the culvert group.  This is done on purpose.  By overlapping these 
stations, the user is allowing the program to calculate the location of the 
stagnation point between these two openings.  This allows the stagnation 
point to vary from one profile to the next.  In the current version of the HEC-
RAS software, stagnation points are allowed to migrate between any bridge 
and culvert group openings.  However, stagnation points must be set to a 
fixed location for any conveyance opening type.  A more detailed explanation 
of stagnation points, and how the program uses them, can be found in the 
HEC-RAS Hydraulics Reference manual, under the section on Multiple 
Openings (Chapter 7). 

 
   Once the user has entered all of the information into the Multiple Opening 

Analysis window, simply press the OK button to accept the data. 
 
 
   Multiple Opening Calculations 
 
   Multiple opening calculations are computationally intensive.  An iterative 

solution approach is used, by which the amount of flow through each opening 
is adjusted until the computed upstream energies of each opening are 
balanced within a predefined tolerance.  The general approach of the solution 
scheme is as follows: 

 
   1. The program makes a first guess at the upstream water surface by 

setting it to the computed energy of the cross section just downstream 
of the bridge. 

 
   2. The program sets an initial flow distribution.  This is accomplished by 

first calculating the amount of active flow area in each opening, based 
on the water surface from step one.  The program then apportions the 
flow by using an area weighting (i.e., if an opening has 40 percent of 
the active flow area, then it will receive 40 percent of the flow). 

 
   3. Once a flow distribution is established, the program then calculates 

the water surface and energy profiles for each opening, using the 
estimated flow. 

 
   4. Once the program has computed the upstream energy for each 

opening, a comparison is made between the energies to see if a 
balance has been achieved (i.e., all energies are within the predefined 
tolerance).  If the energies are not within the set tolerance, the 
program re-distributes the flow based on the computed energies. 
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   5. The program continues this process until either the computed energies 
are within the tolerance or the number of iterations reaches a pre-
defined maximum.  The energy balance tolerance is set as 3 times the 
user entered water surface calculation tolerance (The default is 0.03 
feet or 0.009 meters).  The maximum number of iterations for 
multiple opening analysis is set to 1.5 times the user entered 
maximum number of iterations from the normal water surface 
calculations (the default is 30 for multiple openings). 

 
   A more detailed discussion of how the program performs the multiple 

opening analyses can be found in Chapter 7 of the HEC-RAS Hydraulic 
Reference manual. 

  
 

Inline Structures (Weirs and Gated Spillways) 
 
   HEC-RAS has the ability to model inline weirs and gated structures with 

radial gates (often called tainter gates) or vertical lift gates (sluice gates).  The 
spillway crest of the gates can be modeled as either an ogee shape or a broad 
crested weir shape.   

 
   This section of the User’s manual will describe how to enter the data for 

inline structures.  For information on general modeling guidelines and the 
hydraulic computations of inline weirs and gated spillways, please see 
Chapter 8 of the HEC-RAS Hydraulic Reference manual.  To find out how to 
view specific results for an inline structure, see Chapter 9 of this User’s 
manual. 

 
 
   Entering and Editing Inline Structure Data 
 
   Inline structure data are entered in a similar manner as bridge and culvert 

data.  To enter an inline weir and/or gated spillway press the Inline Structure 
button from the Geometric Data window.  Once this button is pressed, the 
Inline Structure Data editor will appear as shown in Figure 6.28 (except yours 
will be blank until you have entered some data). 
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   Figure 6.28  Inline Structure Data Editor 
 
 
   To add an inline structure to a model, the user must do the following: 
 
   1. Select the river and reach that you would like to place this inline 

structure into.  This is accomplished by first selecting a River, then 
selecting a specific reach within that river.  The River and Reach 
selection buttons are at the top of the Inline Structure Data editor. 

 
   2. Go to the Options menu at the top of the window and select Add an 

Inline Structure from the list.  An input box will appear asking you 
to enter a river station identifier for locating this structure within the 
reach.  After entering the river station, press the OK button and a 
copy of the cross section just upstream of this river station will appear 
on the screen.  This cross section is used in formulating the inline 
structure crossing. 

 
   3. Enter all of the data for the Inline structure.  This data will include a 

Weir/Embankment profile, and any gated spillways that you may be 
modeling.  Gated spillways are optional.  If the user does not enter 
any gated spillways, then the program assumes that there is only an 
inline weir. 
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   4. Once all of the Inline Structure data are entered, press the Apply 
Data button in order for the interface to accept the data.  The editor 
can then be closed by selecting Exit from the File menu at the top of 
the window. 

 
 
   River, Reach, and River Station.  The River and Reach boxes allow the user 

to select a river and reach from the available reaches that were put together in 
the schematic diagram.  The river and reach labels define which river and 
reach the inline structure will be located in.  The River Station tag defines 
where the structure will be located within the specified reach.  The River 
Station tag does not have to be the actual river station of the structure, but it 
must be a numeric value.  The River Station tag for the inline structure should 
be numerically between the two cross sections that bound the structure.  Once 
the user selects Add an Inline Structure from the options menu, an input 
box will appear prompting you to enter a River Station tag for the new 
structure.  After the River Station tag is entered, the cross section just 
upstream of the Inline Structure will be displayed on the editor. 

 
   Description.  The description box is used to describe the Inline Structure 

location in more detail than just the river, reach and river station.  This box 
has a limit of 256 characters.  Only the first line of information is displayed, 
unless the button to the right of the box is pressed.  Also, the first 40 
characters of the description are used as a label for the Inline Structure plots 
and tables. 

 
   Pilot Flow.  This option allows the user to put in a flow rate that will be used 

as a minimum flow release from the structure.  If you have an inline structure 
in HEC-RAS, there must be flow coming out of the structure at all times.  The 
pilot flow option is a simple way to ensure that there is always some flow 
going through the structure. 

 
   Breach (Plan Data).  This button allows the user to define information for 

evaluating the breaching of this inline structure.  The data is actually stored in 
the currently opened plan file.  The editor can also be brought up from the 
plan editor.  This option is only for unsteady flow modeling.  To learn more 
about this option, see Chapter 8 “Performing an Unsteady Flow Analysis.” 

 
   Weir/Embankment.  The Embankment and Weir data are entered together, 

and are used to describe the embankment blocking the stream as well as any 
uncontrolled weirs.  To enter the weir and embankment data, press the 
Weir/Embankment button and the editor will appear (Figure 6-29).  The 
Weir/Embankment Data editor is similar to the Deck/Roadway editor for 
bridges and culverts.  The data on the Weir/Embankment editor is the 
following: 

 
   Distance - The distance field is used to enter the distance between the 

upstream side of the Weir/Embankment (the top of the embankment) and the 
cross section immediately upstream of the structure.  This distance is entered 
in feet (or meters for metric).  
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   Figure 6.29  Weir and Embankment Data Editor 
 
 
   Width - The width field is used to enter the width of the top of the 

embankment along the stream.  The distance between the top of the 
downstream side of the embankment and the downstream bounding cross 
section will equal the main channel reach length of the upstream cross section 
minus the sum of the weir/embankment "width" and the "distance" between 
the embankment and the upstream section.  The width of the embankment 
should be entered in feet (meters for metric). 

 
   Weir Coefficient - Coefficient that will be used for weir flow over the 

embankment in the standard weir equation.  
 
   Station and Elevation Coordinates - This table is used to define the geometry 

of the Weir and the Embankment.  The information is entered from left to 
right in cross section stationing.  The user enters stations and elevations of the 
top of the embankment and weir.  The stationing does not have to equal the 
stations in the bounding cross section, but it must be based on the same 
origin. Everything below these elevations will be filled in down to the 
ground.  The Del Row and Ins Row buttons allow the user to delete and 
insert rows. 

 
   U.S. Embankment SS - This field is used to enter the slope of the road 

embankment on the upstream side of the structure.  The slope should be 
entered as the horizontal to vertical distance ratio of the embankment. 
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    D.S. Embankment SS - This field is used to enter the slope of the road 
embankment on the downstream side of the structure.  The slope should be 
entered as the horizontal to vertical distance ratio of the embankment.  

 
   Weir Crest Shape - When submergence occurs over the weir there are two 

choices available to figure out how much the weir coefficient should be 
reduced due to the submergence.  These two criteria are based on the shape of 
the weir.  The first method is based on work that was done on a trapezoidal 
shaped broad crested weir (FHWA, 1978).  The second criterion was 
developed for an Ogee spillway shape (COE, 1965).  The user should pick the 
criterion that best matches their problem.  If the user selects the Ogee 
Spillway shape, then some additional information is required.  For an Ogee 
shaped weir the user must enter the "Spillway Approach Height" and the 
"Design Energy Head".  The spillway approach height is equal to the 
elevation of the spillway crest minus the mean elevation of the ground just 
upstream of the spillway.  The design energy head is equal to the energy 
grade line elevation (at the design discharge) minus the elevation of the 
spillway crest.  In addition to these two parameters, the user has the option to 
have the program calculate the weir coefficient at the design discharge.  This 
is accomplished by pressing the Cd button.  Once this button is pressed, the 
program will compute a weir coefficient for the Ogee spillway based on the 
design head.  During the weir calculations, this coefficient will fluctuate 
based on the actual head going over the spillway.  The curves used for 
calculating the Ogee spillway coefficient at design head, and discharges other 
than design head, were taken from the Bureau of Reclamation publication 
"Design of Small Dams", Figures 249 and 250 on page 378 (Bureau of 
Reclamation, 1977). 

 
   Gated Spillway Data.  In addition to uncontrolled overflow weirs, the user 

can add gated spillways (this is optional).  To add gated spillways to the 
structure, press the Gate button on the Inline Structure data editor.  Once this 
button is pressed, the gated editor will appear as shown in Figure 6.30 (except 
yours will be blank until you have entered some data). 
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   Figure 6.30  Gated Spillway Editor 
 
 

The Gated Spillway editor is similar to the Culvert editor in concept.  The 
user enters the physical description of the gates, as well as the required 
coefficients, in the Gated Spillway editor.  The functionality of the gates is 
defined as part of the Steady Flow data, on a per profile basis.  The following 
is a list of the data contained on this editor: 
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   Gate Group - The Gate Group is automatically assigned to "Gate #1" the first 
time you open the editor.  The user can enter up to 10 different Gate Groups 
at each particular river crossing, and each gate group can have up to 25 
identical gate openings.  If all of the gate openings are exactly the same, then 
only one gate group needs to be entered.  If the user has gate openings that are 
different in shape, size, elevation, or have different coefficients, then 
additional Gate Groups must be added for each Gate type.  To add an 
additional gate group you can either use the Add or Copy buttons.  The Add 
button increments the Gate # and clears the culvert editor.  The Copy button 
increments the Gate # and makes a copy of the original Gate group data.  
Once a copy is made of a gate data, the user can change any of the existing 
gate information.  Gate groups can be deleted by pressing the Delete button.  
Also, if the gates are identical, but the user wants to be able to open the gates 
to different elevations, then the user must have a separate gate group for each 
set of gates that will be opened to different elevations. 
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   Height - This field is used to enter the maximum possible height that the gate 
can be opened in feet (meters for metric). 

 
   Width - This field is used for entering the width of the gate in feet (meters). 
 
   Invert - This field is used for entering the elevation of the gate invert (sill 

elevation of the spillway inside of the gate) in feet (meters for metric). 
 
   Discharge Coefficient - This field is used for entering the coefficient of 

discharge for the gate opening.  This coefficient ranges from 0.6 to 0.8 for 
Radial gates and 0.5 to 0.7 for sluice gates. 

 
   Gate Type - This field is used for selecting the type of gate.  Two gate types 

are available, radial (tainter gate) or sluice (vertical lift gate). 
 
   Trunnion Exponent - This field is used to enter the trunnion height exponent, 

which is used in the radial gate equation.  The default value for this field is 
0.0. 

 
   Opening Exponent - This field is used to enter the gate opening exponent, 

which is used in the radial gate equation.  A default value of 1.0 is 
automatically set for this field. 

 
   Head Exponent - This field is used to enter the upstream energy head 

exponent, which is used in the radial gate equation.  A default value of 0.5 is 
automatically set for this field. 

 
   Trunnion Height - This field is used for entering the height from the spillway 

crest to the trunnion pivot point.  See Chapter 8 of the Hydraulic Reference 
manual for more details on this variable. 

 
   Orifice Coefficient - This field is used to enter an orifice coefficient, which 

will be used for the gate opening when the gate becomes more than 80 
percent submerged.  Between 67 percent and 80 percent submerged, the 
program uses a transition between the fully submerged orifice equation and 
the free flow equations.  When the flow is less than 67 percent submerged, 
the program uses the free flow gate equations. 

 
   Head Reference – This field is used to select the reference point for which the 

upstream energy head will be computed from.  The default is the gate sill 
(invert), which is normally used when the flow through the gate goes out into 
a channel.  If the gate causes the flow to jet out freely into the atmosphere, 
then the head reference should be selected as the centerline elevation of the 
gate opening.  If the gate crest is an ogee spillway crest, then the center of the 
gate opening should be used.  Ogee spillway crests are normally designed to 
follow the shape of water jetting freely into the atmosphere. 

 
   Centerline Stations - This table is used for entering the centerline stationing 

of the identical gate openings.  The user should enter a different centerline 
stationing for each gate opening that is part of the current gate group.  All 
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gate openings within the same gate group are exactly identical in every way, 
except their centerline stationing.  As a user adds new centerline stationing 
values, the number of identical gates in the group is automatically 
incremented and displayed in the field labeled "# Openings". 

 
   Weir Coefficient - This field is used for entering a weir coefficient that will be 

used for the gate opening.  This coefficient will only be used when the gate is 
opened to an elevation higher than the upstream water surface elevation.  
When this occurs, the flow through the gate is calculated as weir flow.   

 
   Weir Crest Shape - This parameter allows the user to select between a Broad 

Crested shape weir and an Ogee shaped weir.  Depending on which shape is 
selected, the program will use a different submergence criteria during the 
calculation.  In addition to the submergence criteria, if the user selects the 
Ogee shape, the program will bring up two additional data entry fields that 
must be entered by the user.  These fields are used for the Spillway Approach 
Height and the Design Energy Head, which are explained below.  Once these 
fields are entered, the user should press the button labeled Cd.  When this 
button is pressed, the program will compute a weir coefficient for the Ogee 
spillway based on the design head.  During the weir calculations, this 
coefficient will fluctuate based on the actual head going over the gated 
spillway.  The curves used for calculating the Ogee spillway coefficient at 
design head, and discharges other than design head, work taken from the 
Bureau of Reclamation publication "Design of Small Dams", Figures 249 and 
250 on page 378 (Bureau of Reclamation, 1977). 

 
   Spillway Approach Height - The spillway approach height is equal to the 

elevation of the spillway crest minus the mean elevation of the ground just 
upstream of the spillway.   

 
   Design Energy Head - The design energy head is equal to the energy grade 

line elevation (at the design discharge) minus the elevation of the spillway. 
 
   Once all of the data for the gates has been entered, the user needs to press the 

OK button for the data to be accepted.  If the user does not want to use the 
new data, and would like to go back to the original data they had before 
entering the Gate Editor, press the Cancel button.  If the user presses the OK 
button, this does not mean that the data is saved to the hard disk, it is only 
stored in memory and accepted as being good data.  This data is part of the 
geometry data, and is stored in the geometric data file.  The data can be stored 
to the hard disk by selecting one of the save options from the File menu of the 
Geometric Data window. 
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Lateral Structures (Weirs, Gated Spillways, Culverts, 
and Diversion Rating Curves) 
 
   HEC-RAS has the ability to model lateral weirs, gated spillways, culverts, 

and diversion rating curves.  The user can set up a single lateral weir, a weir 
and separate set of gates, a weir and group of culverts, or any combination of 
weir, gates, culverts, and a rating curve.  The gated spillways can have either 
radial gates (often called tainter gates) or vertical lift gates (sluice gates).  The 
spillway crest of the gates can be modeled as either an ogee shape or a broad 
crested weir shape.  The culverts can be any of the available shapes from the 
standard HEC-RAS culvert capability.  The diversion rating curve can be 
used alone, or in conjunction with the other hydraulic outlet types.  The rating 
curve can be used to represent a structure or a particular outlet that could not 
be modeled with HEC-RAS.  Lateral structures can be connected to storage 
areas or another river reach.   

 
   The lateral structure option can also be used to model a levee.  In general, the 

user should end their cross sections at the levee, and then use the later 
structure option to represent the top of the levee along the stream.  The area 
behind the levee could be represented with either a storage area or another 
river reach.  Water that goes above the levee will be modeled as weir flow.  
The user also has the option to evaluate levee breaching. 

 
   This section of the User’s manual will describe how to enter the data for 

lateral weirs, gated spillways, culverts, and lateral rating curves.  For 
information on general modeling guidelines and the hydraulic computations 
of lateral weirs, gated spillways, and culverts, please see Chapter 8 of the 
HEC-RAS Hydraulic Reference manual.  To find out how to view specific 
results for a lateral structure, see Chapter 9 of this User’s manual. 

 
 
   Entering and Editing Lateral Structure Data 
 
   Lateral weir, gated spillway, and culvert data are entered in a similar manner 

as bridge and culvert data.  To enter a lateral structure, press the Lateral 
Structure button from the Geometric Data window.  Once this button is 
pressed, the Lateral Structure Data editor will appear as shown in Figure 6.31 
(except yours will be blank until you have entered some data). 

 
   To add a lateral structure to a model, the user must do the following: 
 
   1. Select the river and reach that you would like to place this lateral 

structure into.  This is accomplished by first selecting a River, then 
selecting a specific reach within that river.  The River and Reach 
selection buttons are at the top of the Lateral Structure Data editor. 

 
   2. Go to the Options menu at the top of the window and select Add a 

Lateral Structure from the list.  An input box will appear asking you 
to enter a river station identifier for locating this structure within the 

 6-67



Chapter 6  Entering and Editing Geometric Data 

reach.  The river station you enter will represent the location of the 
upstream end of the lateral structure. The river station must be unique, 
and should be numerical between the river station values of the 
upstream cross section and the next section downstream. After 
entering the river station, press the OK button and a profile plot of the 
channel invert and cross sections in the vicinity of the lateral 
weir/spillway will be displayed. 

 
 

 
Figure 6.31  Lateral Weir, Gated Spillway, and Culvert Editor 

 
 
   3. Enter all of the data for the Lateral Weir, Gated Spillways, Culverts 

and Diversion Rating Curves.  Gated spillways, culverts, and rating 
curves are optional.  If the user does not enter any gated spillways, 
culverts, or rating curves, then the program assumes that there is only 
a lateral weir.  If the user wants to enter only gated spillways, 
culverts, or a rating curve, and no lateral weir, they must still enter a 
weir embankment. 

 
   4. Once all of the data are entered, press the Apply Data button in order 

for the interface to accept the data.  The editor can then be closed by 
selecting Exit from the File menu at the top of the window.   
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   5. If any gated spillways were entered, the user must go to the Steady or 

Unsteady Flow Data Editor to control the gate settings for each 
individual event. 

 
   The user can have up to two lateral structures defined between any two given 

cross sections.  However, the lateral structure must be placed on opposite 
sides of the channel (i.e. one on the left and one on the right), and the river 
stations of each lateral structure must be different (though still contained 
within the two cross section river station values).  Also, any lateral structure 
can be longer than the distance between cross sections.  The user can have a 
lateral structure that extends downstream, encompassing up to 100 cross 
sections.  If you have a lateral structure that is longer than that, you must 
break it up into separate lateral structure. 

 
   River, Reach, and River Station.  The River and Reach boxes allow the user 

to select a river and reach from the available reaches that were defined in the 
schematic diagram.  The river and reach labels define which river and reach 
the lateral weir and/or gate spillway will be located in.  The River Station tag 
defines where the structure will be located within the specified reach.  The 
River Station tag does not have to be the actual river station of the structure, 
but it must be a numeric value.  The River Station tag for the lateral structure 
should be numerically between the two cross sections that bound the 
upstream end of the structure.  Once the user selects Add a Lateral 
Structure from the options menu, an input box will appear prompting you to 
enter a River Station tag for the new structure.  After the River Station tag is 
entered, a profile plot of the reach thalweg will be displayed for the bounding 
cross sections in the graphic window. 

 
   Description.  The description box is used to describe the Lateral Structure 

location in more detail than just the river, reach and river station.  This box 
has a limit of 256 characters.  Only the first line of information is displayed, 
unless the button to the right of the box is pressed.  Also, the first 40 
characters of the description are used as a label for the Lateral Structure plots 
and tables. 

 
   Position.  The position box is used to define where the lateral structure is 

located spatially within the cross section.  The user can select one of the 
following: Left overbank; Next to left bank station; Next to right bank station; 
and Right overbank.  When the user selects “Left overbank”, the weir is 
assumed to be located at the left end (beginning cross section station) of the 
cross section data, looking in the downstream direction.  When the user 
selects “Next to left bank station”, the weir is assumed to be located on the 
left edge of the main channel.  When the user selects “Next to right bank 
station”, the weir is assumed to be located on the right edge of the main 
channel.  When the user selects “Right overbank”, the weir is assumed to be 
located at the right end of the cross section data. 

 
   Connected To.  This field will display what the lateral structure is connected 

to (i.e. where the water leaving from the main river will be going).  If the 
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structure is not connected to anything, this field will be blank.  A lateral 
structure can be connected to a storage area, another river reach, or nothing at 
all.  The buttons below this field are used to connect the lateral structure, as 
well as remove a connection.  Whatever the lateral structure is connected to is 
where the water will be sent, and will also be used as the tailwater elevation 
for submerged hydraulic calculations.  Water can also flow in the reverse 
direction through a lateral structure if the connected to location has a higher 
water surface than the from location. 

 
   Structure Type.  This field is used to select the type of routing that will be 

used for this structure.  There are two options, Weir/Gates/Culverts/ 
Diversion Rating Curves (the default) and Linear Routing.  The default 
option is where the program calculated the flow across the structure by 
performing detailed hydraulic calculations for the weir, gated spillways, 
culverts, and any rating curve.  The second option, Linear Routing, is a 
simplified method in which the user just puts in a linear routing coefficient.  
This coefficient can vary between 0.0 and 1.0, with 1.0 representing sending 
the maximum flow over the structure and 0.0 representing no flow.  The 
linear routing method is a simple storage accounting method.  This method 
can be very useful when the user has many lateral structures connected to 
storage areas, and a detailed flow calculation over each structure is not 
necessary.  Also, the linear routing method is computationally faster and more 
stable. Typical values for the linear routing coefficient are from 0.05 to 0.2.  
However, this coefficient needs to be calibrated. 

 
   Culvert Flap Gates.  The drop down box right above the Structure Type 

pertains to having flap gates on culverts.  This option only affects the flow 
through the culverts, not the weir or the gated structures.  The options are no 
flap gates (default), no negative flow flap, and no positive flow flap.  No flap 
gates means that flow is allowed to go in both directions through the culvert.  
The no negative flow flap option means that flow can only go in the positive 
flow direction through the culverts.  Positive flow is assumed to be taking 
flow away from the river for a lateral structure.  Therefore, the no negative 
flow flap option would allow water to go away from the main river through 
the culverts, but not back into the river.  The final option, no positive flow 
flap, would only allow water to come into the main river through the culverts, 
but not away from the main river. 

 
   Optimization.  This option is for steady flow modeling only.  When 

modeling in a steady flow mode, the user can have the software figure out 
how much flow will leave through the lateral structure, and how much will 
continue on downstream.  This calculation requires an iterative solution.  
Pressing the Optimization button brings up an editor that allows the user to 
turn the optimization option on.  When optimization is not turned on, the 
program will assume all of the water is still going downstream, though it will 
calculate what could have gone out the lateral weir based on the computed 
water surface.  When optimization is turned on, the software calculates the 
flow out of the lateral structure, reduces the flow in the main river, and then 
recalculates the profile in the main river.  This operation continues until there 
is a balance between the calculated and assumed flows for the main river. 
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   Breach.  This button allows the user to define information for evaluating the 
breaching of this lateral structure.  The data is actually stored in the currently 
opened plan file.  The editor can also be brought up from the plan editor.  
This option is only for unsteady flow modeling.  To learn more about this 
option, see Chapter 16 “Advanced Features For Unsteady Flow Routing.” 

 
   Weir/Embankment.  The Embankment and Weir data are entered together, 

and are used to describe the embankment in which the outlets will be placed, 
as well as any uncontrolled weirs.   To enter the weir and embankment data, 
press the Weir/Embankment button and the editor will appear as shown in 
Figure 6-32.   

  

 
 

   Figure 6.32  Lateral Weir/Embankment editor 
 
 
   The Lateral Weir/Embankment Data editor is similar to the Deck/Roadway 

editor for bridges and culverts.  The data on the Weir/Embankment editor is 
the following: 

 
   Distance - The distance field is used to enter the distance between the 

upstream end of the Weir/Embankment (based on where the user will start to 
enter the embankment data) and the cross section immediately upstream of 
the structure.  This distance is entered in feet (or meters for metric).  

 
   Weir Width - The width field is used to enter the width of the top of the 

embankment.   This value will only be used for graphical plotting, and does 
not have any effect on the computations.  The width of the embankment 
should be entered in feet (meters for metric). 

 
   Weir flow reference - This value is used to select whether weir flow is 

computed by using the energy gradeline or the water surface from the cross 
sections.  The default is to use the energy gradeline.   
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   Weir Coefficient - Coefficient that will be used for weir flow over the 
embankment in the standard weir equation.  

 
   Weir Crest Shape - When submergence occurs over the weir there are two 

choices available to figure out how much the weir coefficient should be 
reduced due to the submergence.  These two criteria are based on the shape of 
the weir.  The first method is based on work that was done on a trapezoidal 
shaped broad crested weir (FHWA, 1978).  The second criterion was 
developed for an Ogee spillway shape (COE, 1965).  The user should pick the 
criterion that best matches their problem.  If the user selects the Ogee 
Spillway shape, then some additional information is required.  For an Ogee 
shaped weir the user must enter the "Spillway Approach Height" and the 
"Design Energy Head".  The spillway approach height is equal to the 
elevation of the spillway crest minus the mean elevation of the ground just 
upstream of the spillway.  The design energy head is equal to the energy 
grade line elevation (at the design discharge) minus the elevation of the 
spillway crest.  In addition to these two parameters, the user has the option to 
have the program calculate the weir coefficient at the design discharge.  This 
is accomplished by pressing the Cd button.  Once this button is pressed, the 
program will compute a weir coefficient for the Ogee spillway based on the 
design head.  During the weir calculations, this coefficient will fluctuate 
based on the actual head going over the spillway.  The curves used for 
calculating the Ogee spillway coefficient at design head, and discharges other 
than design head, were taken from the Bureau of Reclamation publication 
"Design of Small Dams", Figures 249 and 250 on page 378 (Bureau of 
Reclamation, 1977). 

 
   Station and Elevation Coordinates - This table is used to define the geometry 

of the Weir and the Embankment.  The information is entered from upstream 
to downstream in stationing.  The user enters stations and elevations of the 
top of the embankment and weir.  The stationing does not have to equal the 
stations in the river reach.  Everything below these elevations will be filled in 
to the ground.  The Del Row and Ins Row buttons allow the user to delete 
and insert rows. 

 
   Gated Spillway Data.  In addition to uncontrolled overflow weirs, the user 

can add gated spillways (this is optional).  To add gated spillways to the 
structure, press the Gate button on the Lateral Weir and Gated Spillway data 
editor.  Once this button is pressed, the lateral gated editor will appear as 
shown in Figure 6.33 (except yours will be blank until you have entered some 
data). 
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   Figure 6.33  Lateral Gated Spillway Editor. 
 
 

The Gated Spillway editor is similar to the Culvert editor in concept.  The 
user enters the physical description of the gates, as well as the required 
coefficients, in the Gated Spillway editor.  The functionality of the gates is 
defined as part of the Steady Flow data, on a per profile basis.  The following 
is a list of the data contained on this editor: 

 
   Gate Group - The Gate Group is automatically assigned to "Gate #1" the first 

time you open the editor.  The user can enter up to 10 different Gate Groups 
at each particular structure, and each gate group can have up to 25 identical 
gate openings.  If all of the gate openings are exactly the same, then only one 
gate group needs to be entered.  If the user has gate openings that are different 
in shape, size, elevation, or have different coefficients, then additional Gate 
Groups must be added for each Gate type.  To add an additional gate group, 
you can either use the Add or Copy buttons.  The Add button increments the 
Gate # and clears the gate editor.  The Copy button increments the Gate # and 
makes a copy of the original Gate group data.  Once a copy is made of the 
gate data, the user can change any of the existing gate information.  Gate 
groups can be deleted by pressing the Delete button.  Also, if the gates are 
identical, but the user wants to be able to open the gates to different 
elevations, then the user must have a separate gate group for each set of gates 
that will be opened to different elevations. 
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   Height - This field is used to enter the maximum possible height that the gate 
can be opened in feet (meters for metric). 

 
   Width - This field is used for entering the width of the gate in feet (meters). 
 
   Invert - This field is used for entering the elevation of the gate invert (sill 

elevation of the spillway inside of the gate) in feet (meters for metric). 
 
   Discharge Coefficient - This field is used for entering the coefficient of 

discharge for the gate opening.  This coefficient ranges from 0.6 to 0.8 for 
Radial gates and 0.5 to 0.7 for sluice gates. 

 
   Gate Type - This field is used for selecting the type of gate.  Two gate types 

are available, radial (tainter gate) or sluice (vertical lift gate). 
 
   Trunnion Exponent - This field is used to enter the trunnion height exponent, 

which is used in the radial gate equation.  The default value for this field is 
0.0. 

 
   Opening Exponent - This field is used to enter the gate opening exponent, 

which is used in the radial gate equation.  A default value of 1.0 is 
automatically set for this field. 

 
   Head Exponent - This field is used to enter the upstream energy head 

exponent, which is used in the radial gate equation.  A default value of 0.5 is 
automatically set for this field. 

 
   Trunnion Height - This field is used for entering the height from the spillway 

crest to the trunnion pivot point.  See Chapter 8 of the Hydraulic Reference 
manual for more details on this variable. 

 
   Orifice Coefficient - This field is used to enter an orifice coefficient, which 

will be used for the gate opening when the gate becomes more than 80 
percent submerged.  Between 67 percent and 80 percent submerged, the 
program uses a transition between the fully submerged orifice equation and 
the free flow equations.  When the flow is less than 67 percent submerged, 
the program uses the free flow gate equations. 

 
   Head Reference – This field is used to select the reference point for which the 

upstream energy head will be computed from.  The default is the gate sill 
(invert), which is normally used when the flow through the gate goes out into 
a channel.  If the gate causes the flow to jet out freely into the atmosphere, 
then the head reference should be selected as the centerline elevation of the 
gate opening.  If the gate crest is an ogee spillway crest, then the center of the 
gate opening should be used.  Ogee spillway crests are normally designed to 
follow the shape of water jetting freely into the atmosphere. 

 
   Centerline Stations - This table is used for entering the centerline stationing 

of the identical gate openings.  The user should enter a different centerline 
stationing for each gate opening that is part of the current gate group.  All 
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gate openings within the same gate group are exactly identical in every way, 
except their centerline stationing.  As a user adds new centerline stationing 
values, the number of identical gates in the group is automatically 
incremented and displayed in the field labeled "# Openings". 

 
   Weir Coefficient - This field is used for entering a weir coefficient that will be 

used for the gate opening.  This coefficient will only be used when the gate is 
opened to an elevation higher than the upstream water surface elevation.  
When this occurs, the flow through the gate is calculated as weir flow.   

 
   Weir Crest Shape - This parameter allows the user to select between a Broad 

Crested shape weir and an Ogee shaped weir.  Depending on which shape is 
selected, the program will use a different submergence criteria during the 
calculation.  In addition to the submergence criteria, if the user selects the 
Ogee shape, the program will bring up two additional data entry fields that 
must be entered by the user.  These fields are used for the Spillway Approach 
Height and the Design Energy Head, which are explained below.  Once these 
fields are entered, the user should press the button labeled Cd.  When this 
button is pressed, the program will compute a weir coefficient for the Ogee 
spillway based on the design head.  During the weir calculations, this 
coefficient will fluctuate based on the actual head over the gated spillway.  
The curves used for calculating the Ogee spillway coefficient at design head, 
and discharges other than design head, were taken from the Bureau of 
Reclamation publication "Design of Small Dams", Figures 249 and 250 on 
page 378 (Bureau of Reclamation, 1977). 

 
   Spillway Approach Height - The spillway approach height is equal to the 

elevation of the spillway crest minus the mean elevation of the ground just 
upstream of the spillway.   

 
   Design Energy Head - The design energy head is equal to the energy grade 

line elevation (at the design discharge) minus the elevation of the spillway. 
 
   Once all of the data for the gates have been entered, the user needs to press 

the OK button for the data to be accepted.  If the user does not want to use the 
new data, and would like to go back to the original data they had before 
entering the Gate Editor, press the Cancel button.  If the user presses the OK 
button, this does not mean that the data is saved to the hard disk, it is only 
stored in memory and accepted as being good data.  This data is part of the 
geometry data, and is stored in the geometric data file.  The data can be stored 
to the hard disk by selecting one of the save options from the File menu of the 
Geometric Data window. 
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   Culvert Data.  In addition to the lateral weir and gates, the user can also 
enter lateral culverts.  To add culverts to the structure, press the Culvert 
button on the lower left side of the editor.  When this option is selected the 
following window will appear. 

 

    
 
   Figure 6.34  Culvert Editor for Lateral Culverts.  
 
 
   The required culvert data is the same as for an inline culvert.  To see an 

explanation of each field on the editor, review the information on culverts 
found earlier in this chapter.  The only difference is that the centerline 
stationing of each culvert is based on the stationing entered in the 
Weir/Embankment editor. 
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Diversion Rating Curve.  Diversion rating curves are used to remove flow 
from a main river.  The diversion, rating curve can be used in conjunction 
with a lateral weir, gated structures, and culverts, or it can be used alone. 
 
To add a diversion, rating curve to the system, press the “Diversion Rating 
Curve” button on the left hand side of the Lateral Structure editor.  When this 
button is pressed, the following editor will appear: 
 

 
 
Figure 6.35 Lateral Rating Curve Editor 
 
 
The user first selects the type of rating to be used: channel water surface 
versus diverted flow or channel flow versus diverted flow.  Next, the distance 
between the location of the diversion and the cross section just upstream of 
the structure must be entered in order to locate the diversion.  Finally, the user 
enters the actual rating curve.  The curve is entered as the amount of flow 
leaving, verses the elevation of the water in the main river or flow in the main 
river. 
 
Linear Routing Option 
 
The user can choose to use a linear routing option instead of entering 
structure information and having the program compute the flow from the 
structures.  The linear routing option is selected by going to the Structure 
Type pull down and selecting “Linear Routing” from the list.  This option 
uses a coefficient times the difference in available storage between the too 
and from connection.  When this option is selected, a linear routing button 
will appear on the left side of the window.  Selecting the linear routing button 
will bring up the following window: 
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Figure 6.43  Simple Spillway Data Editor 
 
 
As shown in the Linear Routing editor, the user must enter a linear routing 
coefficient for both the positive and negative flow directions.  Additionally, 
the minimum elevation of the spillway crest must be entered.  If both water 
surfaces go below the spillway crest, no flow is passed over the structure. 
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Storage Areas 
 
 

Storage Areas are lake like regions in which water can be diverted into or 
from.  Storage areas can be located at the beginning of a reach, at the end of a 
reach, or they can be located laterally to a reach.  Storage areas can be 
connected to a river reach by using a lateral structure connection.  Storage 
areas can be connected to another storage area by using a storage area 
connection.  Storage area connections consist of a weir, gated spillways and a 
weir, culverts and a weir, or a linear routing option.  An example river system 
with storage areas is shown in Figure 6.36. 
 
 

 
 
 
Figure 6.36  Example Schematic With Storage Areas. 
 
To add a storage area to the river system, first use the storage area drawing 
tool at the top of the geometric editor.  Once the storage area, drawing tool is 
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selected, the user single clicks the left mouse button to begin drawing the 
storage area.  Additional points are added by moving the mouse and single 
clicking.  The storage area will be represented as a polygon.  To finish 
drawing the storage area, double click the left mouse button.  The first and 
last point will then be connected, and the storage area will be filled in with a 
blue color. 
 
After the storage area is drawn, the user must enter data to describe the 
storage area.  This is accomplished with the storage area editor, which is one 
of the buttons on the left side of the geometric editor.  Press the storage area 
editor button and the following editor will appear: 
 

 
 
Figure 6.37  Storage Area Editor 
 
 
As shown in the figure above, the user has two options for entering 
information about the volume of the storage area.  The first option is a simple 
area times a depth option.  The user enters the area of the storage, and a 
minimum elevation.  The storage area is assumed to have the same area at all 
elevations, therefore the volume is dimply the depth times the area.  The 
second option is to enter and elevation versus volume relationship for the 
storage area.  This option provides more detail and accuracy, and is the 
recommended method whenever possible. 
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Storage Area Connections 
 

Storage Area connections are used to link two storage areas together with a 
hydraulic structure.  Storage area connections can consist of a weir; culverts 
and a weir; gated spillways and a weir; or a linear routing option.  To 
establish a hydraulic connection between two storage areas, press the 
“Storage Area Conn” button at the top of the geometric data window.  Once 
the storage area connection drawing tool is invoked, the user simple presses 
the left mouse button one time while over the from storage area, then double 
click the left mouse button while over the too storage area.  This establishes 
the connection between the storage areas, as well as what is considered to be 
the positive flow direction.   
 
Once a connection is made between two storage areas, the user must enter 
information describing the hydraulics of the connection.  This is 
accomplished by pressing the Storage Area Conn editor button on the left 
hand side of the geometric data editor.  When this button is pressed, the 
following window will appear: 

 

 
Figure 6.38  Storage Area Connection Editor 
 
 
As shown in the figure above, the user should first enter a description for the 
storage area connection.  Next the type of routing connection must be selected 
from the drop down box.  As mentioned previously, the user has the choice of 
a weir only; weir and gates; weir and culverts; or linear coefficient routing 
between storage areas.  Once a routing type is selected, the window will place 
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editor buttons specific to that type of routing onto the left side of the editor.  
In this example, because a weir and culverts was selected, the weir, culverts, 
and hydraulic table parameters buttons show up on the window.  The user 
must enter data for each of the buttons shown on the window.  In this 
example it is required to enter a weir/embankment, culvert information, and 
hydraulic table parameters.  When the weir/embankment editor is selected, 
the following window will appear: 
 

 
 
Figure 6.39  Weir/Embankment Editor for Storage Area Connections 
 
 
To complete the data for the weir/embankment between two storage areas, the 
user enters a Weir Width (used only for drawing the schematic); a Weir 
Coefficient (used in the weir flow calculations); a Weir Crest Shape (used 
to assist in the calculation of the weir coefficient, as well as defining 
submergence criteria); and the Station/Elevation Points that describe the top 
of the weir/embankment profile.  The weir/embankment can have up to 500 
points to describe the profile.  The program will use all of the information 
entered by the user for calculating weir flow between the two storage areas.  
After all of the data is entered, simply press the OK button to have the data 
accepted by the program. 
 
If the user has selected the weir and culverts routing type, then culvert 
information must be entered also.  When the culvert editor button is selected, 
the following window will appear: 
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Figure 6.40  Culvert Editor for Storage Area Connections 
 
The culvert editor shown above has exactly the same information as the 
normal culvert editor used at a river crossing.  For detailed information about 
this editor, please review the section on culverts found earlier in this chapter. 
 
Whenever the user selects a weir, or a weir and culvert routing type, and 
additional button will appear on the editor labeled “Htab Param”.  This 
editor is used to define the limits of the family of rating curves that will be 
developed for the storage area connection.  When this button is pressed, the 
following editor will appear: 
 

 
Figure 6.41  Hydraulic Properties Table Editor 
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As shown in Figure 6.41, the user must enter a number of points for the free 
flow curve (default is 40, max 50); number of submerged curves (default is 
40, max 50); number of points on the submerged curves (default is 10, max 
20); and head water maximum elevation.  Additionally, the user can enter a 
tailwater maximum elevation; maximum swell head (difference between 
headwater and tailwater); and a maximum flow rate.  All of these parameters 
are used to define the limits of the family of rating curves that get created 
when the geometric pre-processor runs. 
 
If the user has selected the Weir and Gates option, an editor for gated 
spillways will show up on the left hand side of the window.  Pressing this 
button will bring up the window shown in Figure 6.42.  As shown in the 
figure, this editor is the same gate editor that is used for inline and lateral 
gated spillways.  For information about this editor, please review the sections 
on inline and lateral gated spillways found earlier in this chapter. 
 

 
 
Figure 6.42  Gated Spillway Editor for Storage Area Connections 
 
 
The final option for Storage Area Connections is to model the connection as a 
Linear Routing Method.  This option uses a coefficient times the difference 
in available storage between the two storage areas, divided by the time step.  
When this option is pressed, the following window will appear: 
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Figure 6.43  Simple Spillway Data Editor 
 
 
As shown in the Linear Routing editor, the user must enter a linear routing 
coefficient for both the positive and negative flow directions.  Additionally, 
the minimum elevation of the spillway crest must be entered.  If both water 
surfaces go below the spillway crest, no flow is passed between the storage 
areas. 
 
 

Pump Stations 
 

A pump station can be used to pump water between two storage areas, a 
storage area and a river reach, or between two river reaches.  Each pump 
station can have up to ten different pump groups, and each pump group can 
have up to twenty identical pumps.  To add a pump station to the system, 
select the Pump Station drawing tool at the top of the geometric data editor.  
When this button is pressed, the mouse icon will change to a set of cross hairs 
with a pump.  Move the mouse to the location that represents where the pump 
station will be pumping from, press the left mouse button to start the 
connection.  Next, move the mouse to the location where the pump station 
will be pumping too, then press the left mouse button again.  This will 
establish a pump station connection between two elements. 
 
Once a pump station is added to the system, the user must edit the pump 
station and fill in the required data.  To bring up the pump station editor, 
select the pump station editor button on the left hand side of the geometric 
data editor, or move the mouse over the pump station icon on the schematic, 
press down on the left mouse button, then select Edit Pump Station.  When 
the Pump Station editor is selected, the following window will appear: 
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Figure 6.44  Pump Station Editor with Pump Connection Data 
 
As shown in Figure 6.44, there are two tabs on the pump station editor, one is 
for the pump connection data, and the other is for the pump group data.  The 
pump connection data contains the following data: 
 
Rename Pump Station:  This option allows the user to rename the pump 
station to something other than the default. 
 
Pump From:  This is the location of where the pump station is pumping from.  
This can be either a storage area or a river station from a river reach. 
 
Pump To:  This is the location of where the pump station is pumping to.  This 
can be either a storage area or a river station from a river reach. 
 
On-Off Reference:  By default the program uses the “Pump From” location to 
determine when the pump should turn on or off.  However, the user has the 
option to set a different location to be used as the monitor point for 
determining whether the pump should be turned on or off.  This optional 
monitor location can be a storage area or a river station within a river reach. 
 
Highest elevation in pump line:  This option allows the user to enter an 
elevation to be used as the highest elevation in the pump line.  One example 
of where this may be useful is if a pump station was being used to pump 
water over top of a levee.  In this situation, the to and from water surface 
elevations does not completely quantify the required head to pump the water 
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over the levee.  So it is necessary to enter the elevation of the highest point in 
the pump line (top of the levee) in order to accurately compute the flow going 
through the pump. 
 
Steady Flow Optimization:  This option is for steady flow modeling only.  If 
water is being pumped from or to a river reach, the amount of flow going into 
or out of the reach should be accounted for when computing the water surface 
profiles.  However, the water surface profiles will affect the computation of 
the amount of flow through the pumps.  Therefore, to calculate this 
accurately, the pump flow and water surface profiles must be calculated 
iteratively until a balance is found between the river flows and the pump 
flows.  This optimization feature is not done automatically by the steady flow 
program, however, the user can have the program do this by selecting Steady 
flow optimization.   When this option is selected, a window will appear 
allowing the user to turn the pump flow optimization on. 
 
In addition to the pump connection data the user must fill out the pump group 
data.  Select the Pump Group Data tab and the editor will look like the 
following: 
 

 
 
Figure 6.45  Pump Station Editor With Pump Group Data. 
 
As shown in Figure 6.45, the pump group data consists of the following: 
 
Group Name:  By default the first pump group is called “Group #1”, and the 
second would be “Pump Group #2”, etc.  The user has the option to rename 
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any pump group to whatever they would like.  This is done by pressing the 
“Rename Group” button. 
 
Add Group:  This button is used to add another pump group.  If you have 
pumps that have different flow capacities and use different pump efficiency 
curves, they must be entered as a separate pump group. 
 
Delete Group:  This button is used to delete the current pump group. 
 
Number of Pumps in Group:  This field is used to enter the number of 
identical pumps in the current pump group.  Identical pumps must use the 
same pump efficiency curve but can have different on and off trigger 
elevations. 
 
Bias group operations to on (Steady Flow Only):  This option is only relevant 
for a steady flow run.  When this option is selected, and a particular water 
surface profile is between the on and off elevation for a pump, the program 
will assume the pump is turned on.  If this option is not checked, then the 
program will assume the pump is off when the water surface is between the 
on and off elevations. 
 
Pump Efficiency Curve:  This table is used to enter the pump efficiency curve, 
which is a table of pump head versus flow rate.  The head represents the total 
head in the system, which is normally the difference in the water surface 
elevations between the from and the to location, plus any friction losses and 
minor losses in the pump line.  The flow is the pump rate capacity at that 
particular head.  The pump efficiency curve can be plotted for visual 
inspection by pressing the Plot Pump Curves button at the bottom of the 
window. 
 
Pump Operations:  This table is used to define the trigger elevations for when 
the pumps will turn on and off.  The monitor location for triggering a pump 
on or off is by default the from location, unless otherwise specified in the 
Optional On-Off Reference field.  In general, the pump on elevation must be 
higher than the pump off elevation.  Trigger elevations must be specified for 
all of the pumps. 
 
After all of the pump data are entered, press the OK button to have the data 
excepted by the program.  This does not save the data to the hard disk, it only 
allows it to be used in the current execution of the program.  To save the data 
permanently, you must save the geometry data from the File menu of the 
Geometric Data Editor. 
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Cross Section Interpolation 
 
   Occasionally it is necessary to supplement surveyed cross section data by 

interpolating cross sections in between two surveyed sections.  Interpolated 
cross sections are often required when the change in velocity head is too large 
to accurately determine the energy gradient.  An adequate depiction of the 
change in energy gradient is necessary to accurately model friction losses as 
well as contraction and expansion losses. 

 
   Cross section interpolation can be accomplished in three ways from within 

the HEC-RAS interface.  The first method is to simply copy one of the 
bounding cross sections and then adjust the station and elevation data.  The 
cross section editor allows the user to raise or lower elevations and to shrink 
or expand various portions of any cross section.  The second and third options 
allow for automatic interpolation of cross section data.  From the Geometric 
Data editor, automatic interpolation options are found under the Tools menu 
bar as shown in Figure 6.46. 

 

 
 
   Figure 6.46  Automatic Cross Section Interpolation Options 
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The first cross section interpolation option, Within a Reach, allows for 
automatic interpolation over a specified range of cross sections within a 
single reach.  When this option is selected, a window will pop up as shown in 
Figure 6.47.  The user must first select the River and Reach that they would 
like to perform the interpolation in.  Next the user must select a starting River 
Station and an ending River Station for which interpolation will be 
performed.  The user must also provide the maximum allowable distance 
between cross sections.  If the main channel distance between two sections is 
greater than the user defined maximum allowable, then the program will 
interpolate cross sections between these two sections.  The program will 
interpolate as many cross sections as necessary in order to get the distance 
between cross sections below the maximum allowable.  Additionally the user 
can specify the number of decimal places used for the stationing and 
elevations of the interpolated cross sections. 

 

 
 
   Figure 6.47  Automatic Cross Section Interpolating Within a Reach 
 
 
   Once the user has selected the cross section range and entered the maximum 

allowable distance, cross section interpolation is performed by pressing the 
Interpolate XS's button.  When the program has finished interpolating the 
cross sections, the user can close the window by pressing the Close button.  
Once this window is closed, the interpolated cross sections will show up on 
the river schematic as light green tic marks.  The lighter color is used to 
distinguish interpolated cross sections from user-entered data.  Interpolated 
cross sections can be plotted and edited like any other cross section.  The only 
difference between interpolated sections and user-defined sections is that 
interpolated sections will have an asterisk (*) attached to the end of their river 
station identifier.  This asterisk will show up on all input and output forms, 
enabling the user to easily recognize which cross sections are interpolated and 
which are user defined.   
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   The second type of automatic cross section interpolation, Between 2 XS's, 
allows the user to have much greater control over how the interpolation is 
performed.  When this option is selected, a Cross Section Interpolation 
window will appear as shown in Figure 6.48.  

 

  
 
   Figure 6.48  Detailed Cross Section Interpolation Window  
   
 

 This cross section interpolation window displays only two cross sections at a 
time.  The user can get to any two cross sections from the River, Reach and 
River Station boxes at the top of the window.  Interpolated cross section 
geometry is based on a string model as graphically depicted in Figure 6.46.  
The string model consists of chords that connect the coordinates of the 
upstream and downstream cross sections.  The cords are classified as master 
and minor cords.  As shown in Figure 6.48, five master cords are 
automatically attached between the two cross sections.  These master cords 
are attached at the ends of the cross sections, the main channel bank stations, 
and the main channel inverts.  Minor cords are generated automatically by the 
interpolation routines.  A minor cord is generated by taking an existing 
coordinate in either the upstream or downstream section and establishing a 
corresponding coordinate at the opposite cross section by either matching an 
existing coordinate or interpolating one.  The station value at the opposite 
cross section is determined by computing the decimal percent that the known 
coordinate represents of the distance between master cords and then applying 
that percentage to the opposite cross section master cords.  The number of 
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minor cords will be equal to the sum of all the coordinates of the upstream 
and downstream sections minus the number of master cords.  Interpolation at 
any point in between the two sections is then based on linear interpolation of 
the elevations at the ends of the master and minor cords.  Interpolated cross 
sections will have station and elevation points equal to the number of major 
and minor cords. 

 
   This interpolation scheme is used in both of the automated interpolation 

options ("Within a Reach" and "Between 2 XS's").  The difference is that the 
Between 2 XS's option allows the user to define additional master cords.  
This can provide for a better interpolation, especially when the default of five 
major cords produces an inadequate interpolation.  An example of an 
inadequate interpolation when using the default cords is shown below. 

 

 
 
   Figure 6.49  Cross Section Interpolation Based on Default Master Cords 
 
   As shown in Figure 6.49, the interpolation was adequate for the main channel 

and the left overbank area.  The interpolation in the right overbank area failed 
to connect two geometric features that could be representing a levee or some 
other type of high ground.  If it is known that these two areas of high ground 
should be connected, then the interpolation between these two sections should 
be deleted, and additional master cords can be added to connect the two 
features.  To delete the interpolated sections, press the Del Interp button. 
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   Master cords are added by pressing the Master Cord button that is located to 
the right of the Maximum Distance field above the graphic.  Once this button 
is pressed, any number of master cords can be drawn in.  Master cords are 
drawn by placing the mouse pointer over the desired location (on the upper 
cross section), then while holding the left mouse button down, drag the mouse 
pointer to the desired location of the lower cross section.  When the left 
mouse button is released, a cord is automatically attached to the closest point 
near the pointer.  An example of how to connect master cords is shown in 
Figure 6.50. 

 

    
 
   Figure 6.50  Adding Additional Master Cords for Interpolation 
    
 
   User defined master cords can also be deleted.  To delete user defined master 

cords, press the scissors button to the right of the master cords button.  When 
this button is pressed, simply move the mouse pointer over a user defined 
cord and click the left mouse button to delete the cord. 

 
   Once you have drawn in all the master cords that you feel are required, and 

entered the maximum distance desired between sections, press the 
interpolate button.  When the interpolation has finished, the interpolated 
cross sections will automatically be drawn onto the graphic for visual 
inspection.  An example of this is shown in Figure 6.51. 
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   Figure 6.51  Final Interpolation With Additional Master Cords 
 
 
   As shown in Figure 6.51, the interpolation with the addition of user defined 

master cords is very reasonable.   
 
   In general, the best approach for cross section interpolation is to first 

interpolate sections using the "Within a Reach" method.  This provides for 
fast interpolation at all locations within a reach.  The "Within a Reach" 
method uses the five default master cords, and is usually very reasonable for 
most cross sections.  Once this is accomplished, all of the interpolated 
sections should be viewed to ensure that a reasonable interpolation was 
accomplished in between each of the cross sections.  This can be done from 
the "Between 2 XS's" window.  Whenever the user finds interpolated cross 
sections that are not adequate, they should be deleted.  A new set of 
interpolated cross sections can be developed by adding additional master 
cords.  This will improve the interpolation. 

 
   CAUTION:  Automatic geometric cross section interpolation should not be 

used as a replacement for required cross section data.  If water surface profile 
information is required at a specific location, surveyed cross section data 
should be provided at that location.  It is very easy to use the automatic cross 
section interpolation to generate cross sections.  But if these cross sections are 
not an adequate depiction of the actual geometry, you may be introducing  
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   error into the calculation of the water surface profile.  Whenever possible, use 
topographic maps to assist you in evaluating whether or not the interpolated 
cross sections are adequate.  Also, once the cross sections are interpolated, 
they can be modified just like any other cross section.   

 
   If the geometry between two surveyed cross sections does not change 

linearly, then the interpolated cross sections will not adequately depict what is 
in the field.  When this occurs, the modeler should either get additional 
surveyed cross sections, or adjust the interpolated sections to better depict the 
information from the topographic map. 

 
    

River Ice  
 

The current version of HEC-RAS allows the user to model ice-covered 
channels. This section of the users manual will describe how to enter the data 
describing the ice cover and the ice cover properties. If the ice cover 
geometry is known, that is, if the ice cover thickness and roughness are 
known throughout the reaches of interest, the user can supply these data and 
describe the ice cover directly. If the ice cover results from a wide-river type 
jam, HEC-RAS will estimate the jam thickness in reaches where the ice jam 
occurs. In this case, the user can supply the material properties of the jam or 
use the default values. To find out how to view specific results for a channel 
with an ice cover, see Chapter 9 of this User’s manual. 
 

   Entering and Editing Ice Data 
 
River ice data can be entered in two ways: by using the Add Ice Cover 
option under the Options Menu found at the top of the Cross Section Data 
Editor (Figure 6.2), or by using Tables Menu found at the top of the 
Geometric Data window (Figure 6.1). Both ways of entering data will be 
described below. It is important to remember that at least two cross sections 
are required to define the ice cover. A cross section should be placed at the 
upstream and downstream ends of each ice-covered reach. 

 
Entering Ice Data at a Cross Section 
 
To enter river ice data the user presses the Cross Section button on the 
Geometric Data window (Figure 6.1). Once the cross section button is pressed 
the Cross Section Data Editor will appear as shown in Figure 6.2. See the 
CROSS SECTION DATA section of the User’s Manual, for information on 
selecting the appropriate river, reach, and cross section in the Cross Section 
Data Editor. Once a cross section with an ice cover has been selected, choose 
the "Add ice cover..." option under the Options Menu found at the top of the 
Cross Section Data Editor (Figure 6.2).  This will open the Ice Cover Editor 
(Figure 6.52).  All ice data for this cross section can be entered with this 
editor. 
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   Figure 6.52  Ice Cover Editor 

 
 
 
Ice Cover Thickness. The ice cover thickness in the left overbank (LOB), 
main channel (Channel), and right overbank (ROB), are entered here. If there 
is no ice in any of these areas, a thickness of zero should be entered. 
 
Ice Cover Manning’s n Values. The Manning’s n value of the ice cover in 
the left overbank (LOB), main channel (Channel), and right overbank (ROB), 
are entered here. If any part of a cross section has a non-zero ice thickness, a 
Manning’s n value must be supplied. 
 
Ice Cover Specific Gravity. The default value is 0.916. The user can supply 
an alternative value here.      

 
Wide River Ice Jam. The boxes under this option are checked if this section 
is to be treated as a wide river ice jam. In this case, HEC-RAS will estimate 
the jam thickness using the complete ice jam force balance as described in the 
Hydraulic Reference Manual. The user can confine the jam to the main 
channel or allow the jam to be in the channel and overbank areas by checking 
the proper boxes. If the ice cover is confined to the channel, the overbanks 
can have a known ice thickness (including an ice thickness of zero) assigned 
to them in the Ice Cover Thickness option. If the Wide River Ice Jam option 
is selected, an ice cover thickness must be supplied for the main channel 
using the Ice Cover Thickness Option or through the Ice Tables (see below). 
This ice cover thickness will be used as the initial estimate of the ice jam 
thickness and will also serve as the minimum thickness allowed for the ice 
jam at that section. If the jam is allowed in the overbank areas, the channel 
and overbanks hydraulic properties will be combined to calculate a single jam 
thickness for the channel and overbanks. NOTE: A wide river jam cannot be 
selected for an entire river channel. A cross section with fixed ice cover 
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geometry must be included at the upstream end and the downstream end of 
the wide river ice jam to serve as the boundary conditions for the jam. There 
is no limit to the number of separate wide river jams that can exist in a river 
network. However, every ice jam must have a cross section with fixed ice 
geometry at its upstream and downstream limit. Ice jams can extend through 
any number of junctions. However, the jam will only be extended between 
reaches that have identical reach names. 
 
Internal Friction Angle of the Jam (degrees). This describes the "strength" 
of the ice jam as a granular material. The default value is 45_degrees. 
 
Ice Jam Porosity (fraction water filled). This describes the fraction of the 
ice jam that is filled with liquid water. The default value is 0.4. 
 
Coefficient K1 (longitudinal to lateral stress in jam). This describes the 
ratio of the lateral stress and the longitudinal stress in the jam. It is the 
efficiency of the jam in transferring longitudinal stress into lateral stress 
against the channel banks. The default value is 0.33 
 
Maximum mean velocity under ice cover. This option limits the maximum 
mean velocity under a wide river ice jam. The default value is 5 fps. If the 
maximum mean velocity is greater than this, the ice cover will be thinned 
until the maximum velocity is attained, or the minimum ice thickness 
supplied by the user is reached. In any case, the jam thickness will not be 
allowed to be thinner than the user supplied thickness. This option prevents 
the jam from thickening to such an extent that the entire cross sectional area 
of the channel would become blocked. 
 
Ice Cohesion. At present, the ice jam cohesion is set to the default value of 
zero. This cannot be changed by the user. A value of zero is appropriate for 
breakup ice jams. 
 
Fixed Manning’s n Value (or Nezhikovsky’s data will be used). The 
Manning’s n value of the ice jam can be specified by the user or estimated 
using the empirical relationships developed from Nezhikovsky’s data (1964). 
The empirical relationships estimate the Manning’s n value on the basis of the 
jam thickness and the total water depth. The default is the user supplied 
Manning’s n value. 
 
Once all the ice data have been entered and edited, click the OK button. At 
the bottom of the Cross Section Data Editor, in the space entitled "List of 
special notes for cross section," the words "Ice cover" will now appear. The 
user can now click on the words "Ice cover" to return to the ice cover editor 
for that cross section. 
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Entering Ice Data Through a Table  
 
Ice cover information can also be entered using the Tables Menu found at the 
top of the Geometric Data Window (Figure 6.1). To enter data the user selects 
the Ice Cover Option under the Tables Menu. All the information that can be 
entered under the Ice Cover Editor can also be entered using the Ice Cover 
table. It is often very convenient to enter and view data for more than one 
cross section at a time (Figure 6.53).  
 

 
 
   Figure 6.53  Entering ice information using a Table 
 
  

The user has the option of entering the ice thickness in the left overbank 
(LOB ice Thickness), the main channel (Chan ice Thickness), and the right 
overbank (ROB ice Thickness); the Manning’s n value of the left overbank 
ice cover (LOB ice Mann n), the main channel ice cover (Chan ice Mann n), 
and the right overbank ice cover (ROB ice Mann n); and the specific gravity 
of the ice cover (Ice gravity). The user can also choose if the ice cover in the 
main channel is the result of a wide river ice jam (Ice Jam Chan. Note: only y 
or n can be entered here), and choose if the overbanks are also included in 
the wide river ice jam (Ice Jam OB. Note: only y or n can be entered here). 
The user can further select the internal friction angle of the ice jam (Friction 
Angle); the porosity of the ice jam (Porosity); the longitudinal to lateral stress 
ratio of the ice jam (Stress K1 ratio); the maximum allowable under ice flow 
velocity (Max Velocity); and if the Manning’s n value of the ice jam is fixed, 
that is selected by the user, or if the Manning’s n value will be determined by 
HEC-RAS (Note: only y or n can be entered here).  
 
As in all instances where a Table is used to enter data, in each column the 
user has the option of entering one or more values, adding a constant to one 
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or more of the values, multiplying a group of values by a factor, or changing a 
group of values to a specific value. Additionally, cut, copy, and paste buttons 
are provided to pass data to and from the Windows Clipboard.  
 

 
Entering Ice Data at Bridges  
 
The influence of ice on the hydraulics of bridges is a relatively unstudied 
area. Little is known about the ways in which a wide river ice jam interacts 
with the various components of a bridge. The important components of a 
bridge that may interact with an ice jam include the piers, low chord, 
approaches, and deck. Previous investigations of ice jams in rivers with 
bridges have largely ignored their presence, arguing that observed ice jams 
did not contact the low steel significantly. Removing the bridge information 
for an ice jam study still remains an option. However to allow a user to 
efficiently use HEC-RAS with ice and with bridges, three separate options 
are provided. These options allow the user to selectively decide at each bridge 
whether or not the ice cover can interact with the structure. When modeling 
ice at bridges, users should carefully evaluate the results for consistency and 
accuracy.  
 
Ice information at bridges is entered using the Bridge/Culvert editor found 
under the Geometry editor. Use the options menu in the Bridge/Culvert editor 
to select the ice option. This will open a window as shown in Figure 6.54. 
 

 
 
   Figure 6.54  Entering ice information at bridges 

 
 
No ice computed in the bridge. In this case no ice calculations will be 
preformed at the bridge itself and the ice thickness at the bridge will be 
assumed to be zero. 
 
Ice remains constant through the bridge. In this case, the ice thickness at 
the cross section immediately upstream of the bridge will be used. If the ice 
thickness is calculated as a wide river jam, this thickness will be used. 
 
Dynamic ice jam computed through the bridge. In this case, the wide river 
ice jam calculations will be preformed at the bridge cross section. The user 
must check for inconsistent results, especially if any part of the ice jam is 
above the low chord of the bridge. 
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Setting Tolerances for the Ice Jam Calculations  
 
The user can override the default settings for the ice jam calculation 
tolerances which are used in the solution of the ice jam force balance 
equation. The tolerances are set as multiples of the water surface calculation 
tolerance used in the solution of the energy equation, described in the 
Simulation Options section of Chapter 7. The user can change the values of 
these tolerances by changing the water surface calculation tolerance. The 
tolerances are as follows: 
 
Ice thickness calculation tolerance. This tolerance is compared with the 
difference between the computed and assumed ice thickness at a cross 
section. It is set to ten times the water surface calculation tolerance. Its 
default value is 0.1 ft. 
 
Global ice thickness calculation tolerance. This tolerance is compared with 
the difference between the computed ice thickness at each cross section 
between successive solutions of the ice jam force balance equation and the 
energy equation. It is set to ten times the water surface calculation tolerance. 
Its default value is 0.1 ft. 
 
Global water level calculation tolerance. This tolerance is compared with 
the difference between the computed water surface elevations at each cross 
section between successive solutions of the ice jam force balance equation 
and the energy equation. It is set to six times the water surface calculation 
tolerance. Its default value is 0.06 ft. 
 
Maximum number of ice jam iterations. This variable defines the 
maximum number of times for successive solutions of the ice jam force 
balance equation and the energy equation. It is set to 2.5 times the maximum 
number of iterations. Its default value is 50. 
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Viewing and Editing Data Through Tables 
 
   Once cross-section data are entered, the user can view and edit certain types 

of data in a tabular format.  The current version of HEC-RAS allows the user 
to view and edit Manning’s n or k values, cross-section reach lengths, 
contract and expansion coefficients, ice cover, cross-section river stationing, 
and node names.  These options are available from the Tables menu option 
on the Geometric Data editor.  The following is a description of each option. 

 
   Manning’s n or k values 
 
   It is often desirable to view and edit the Manning’s n values or roughness 

heights (k values) for several cross sections all at the same time.  From the 
Geometric Data editor, the user can select Manning’s n or k values from 
the Tables menu item.  Once this option is selected, a window will appear as 
shown in Figure 6.55. 

 
   As shown in Figure 6.55, the user has the options of selecting either n or k 

values to be used as the roughness coefficient, add a constant to one or more 
of the n or k values, multiply a group of n or k values by a factor, or change a 
group of n or k values to a specific value.  Additionally, cut, copy, and paste 
buttons are provided to pass data to and from the Windows Clipboard. 

 
   To add a constant to a group of n or k values, the user must first highlight the 

values that they would like to change.  Highlighting is accomplished by 
placing the mouse in the upper left cell of the desired cells to highlight, then 
press the left mouse button and drag the cursor to the lower left corner of the 
desired cells to highlight.  When the left mouse button is released, the cells 
that are selected will be highlighted (except the first cell).  Once the user has 
highlighted the desired cells to be modified, press the Add Constant button.  
This will bring up a pop up window, which will allow the user to enter a 
constant value that will be added to all cells that are highlighted. 

 

 6-101



Chapter 6  Entering and Editing Geometric Data 

 
 
   Figure 6.55  Manning’s n Data View and Editing Table 
 
 
   To multiply a group of n or k values by a factor, the user first highlights the 

desired cells.  Once the cells are highlighted, pressing the Multiply by a 
Factor button will bring up a pop up window.  This window allows the user 
to enter a value that will be multiplied by each of the highlighted cells. 

 
   To set a group of n or k values to the same number, the user must first 

highlight the values that they would like to change.  Once the cells are 
highlighted, pressing the Set Values button will bring up a pop up window.  
This window will allow the user to enter a specific n or k value, which will 
replace all of the highlighted values. 

 
   The user can also go directly into the table and change any individual values. 
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   Reach Lengths 
 
   The user has the ability to view and edit cross section reach lengths in a 

tabular format.  This is accomplished by selecting Reach Lengths from the 
Tables menu of the Geometric Data editor.  Once this option is selected, a 
window will appear as shown in Figure 6.56.  The user has the same editing 
features as described previously for the n values table.  See the discussion 
under Manning’s n or k values, in the previous section, for details on how to 
edit the data. 

 

 
 
   Figure 6.56  Reach Lengths View and Editing Table 
 
 
    Contraction and Expansion Coefficients 
 
   The user has the ability to view and edit contraction and expansion 

coefficients in a tabular format.  This is accomplished by selecting 
Coefficients from the Tables menu of the Geometric Data editor.  Once this 
option is selected, a window will appear as shown in Figure 6.57.  The user 
has the same editing features as described previously for the n values table.  
See the discussion under Manning’s n values, in the previous section, for 
details on how to edit the data. 
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   Figure 6.57  Contraction and Expansion Coefficients Table 
    
 

Bank Stations 
 

This table allows the user to set or move the main channel bank stations.  If 
the main channel bank stations have not been set, and the user brings up this 
table, the bank stations will be set to the ends of the cross section.  If the bank 
stations are already set the user can adjust the bank stations by adding a 
constant, multiplying them by a factor, or setting them to a specific value.  If 
the new bank stations do not exist in the cross section, the program will 
automatically interpolate them. 
 
Levees 

 
This table allows the user to easily enter and edit levee stations and 
elevations.  The editor allows the user to quickly move levee stations and/or 
elevations.  This can be very useful when trying to decide on a location for 
levee setbacks and their corresponding elevations. 
 
 

   Ice Cover 
 

This option allows the user to enter ice cover data in a tabular form.  A 
detailed discussion of ice cover information was presented earlier in this 
chapter. 
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   River Stationing 
 

This option allows the user to view and edit the cross section river stationing 
in a tabular form.  This is accomplished by selecting River Stations from the 
Tables menu of the Geometric Data editor.  Once this option is selected, a 
window will appear as shown in Figure 6.58.  This table allows the user to 
change the river stationing of individual cross sections, add a constant value 
to the river stationing of selected cross sections (those cross sections 
highlighted by the user), multiply the selected cross sections river stationing 
by a factor, or to renumber the cross section river stationing based on the 
main channel reach lengths 

 
 

 
  
   Figure 6.58  Cross Section River Stationing View and Editing Table 
 
   Node Names 
 
 This option allows the user to add an additional name to a node (a node is a 

cross section, bridge, culvert, inline structure, etc…).  The name can be up to 
16 characters long.  The user can request that the name be displayed on a 
profile plot or on a cross-section plot.  To use this feature, select Node 
Names from the Tables menu.  When this option is selected a window will 
appear as shown in Figure 6-59.  Enter any text name that you want at a 
desired location within the model. 
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 Figure 6.59  Node Name Table Editor 
 
 

Node Descriptions 
 

This table allows the user to enter a description for any node (cross section, 
bridge, culvert, inline structure, lateral structure, and pump stations).  The 
description can be up to six rows of text.  The table allows the user to display 
any number of the rows at one time.  The user can request that the description 
be displayed on a profile plot or on a cross-section plot.  To use this feature, 
select Node Descriptions from the Tables menu.  Enter any text description 
that you want at a desired location within the model. 
 
Picture File Associations 
 
This table allows the user to see and edit the directories that pictures are 
attached to for the project.  For example, if all of the pictures for a project 
were in a directory separate from the project, and these pictures were then 
moved to another directory, this table would allow you to easily change the 
associated directory for the pictures. 

 
 Bridge Width Table 
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 This option allows the user to view and/or modify bridge width and distance 
data.  Previous versions of HEC-RAS (versions 2.21 and earlier) allowed the 
user to enter a zero length between the cross sections inside of a bridge and 
the cross sections just outside of the bridge.  This creates and unrealistic 
water surface profile in the vicinity of the bridge.  Current versions require 
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the user to maintain some distance between the outside cross sections and the 
bridge structure.  This table was added to make the process of modifying old 
data sets less painful.  When this option is selected, a window will appear as 
shown in Figure 6-60.  As shown in Figure 6-60, the user is given the length 
between the cross sections that bound the bridge, the distance between the 
upstream cross section and the bridge, the bridge width, and the distance 
between the downstream cross section and the bridge.  The user must ensure 
that the upstream and downstream distances are greater than zero.  This will 
require entering an upstream distance, and then changing the bridge width to 
allow for a positive downstream distance. 

 

 
 
Figure 6.60  Bridge Width and Distance Table 
 
 
Weir and Gate Coefficient Table 
 
This table allows the user to see and edit all of the weir and gate coefficients 
for all of the inline and lateral structures within the model. 

 
Importing Geometric Data 
 
   HEC-RAS has the ability to import geometric data in several different 

formats.  These formats include: a GIS format (developed at HEC); the 
USACE Standard Surveyor format; HEC-2 data format; HEC-RAS data 
format; UNET geometric data format; and the MIKE11 cross section data 
format.  Data can be imported into an existing HEC-RAS geometry file or for 
a completely new geometry file.   Multiple data files can be imported into the 
same geometric data file on a reach-by-reach basis. 
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   To import data into a HEC-RAS geometric data file, the user selects the 
Import Geometric Data option from the File menu of the Geometric Data 
window.  Once this option is selected, the user then selects one of the three 
available formats from the list.  After a format is selected, the user will be 
asked if they want to add the data to the current geometry file, or if they want 
to clear the current geometry file before importing the data.  Once this choice 
is made, the user will be prompted to enter the name of the file containing the 
data.  The following is a discussion of each of the three file formats. 

 
   GIS Format 
 
   A file format for interfacing HEC-RAS with GIS/CADD systems has been 

developed at HEC.  A detailed description of the file format is contained in 
Appendix B of this manual.  Chapter 14 of this manual provides detailed 
discussions on how to import GIS/CADD data into HEC-RAS, as well as 
how to export computed water surface profiles back to GIS/CADD systems. 

 
   USACE Survey Data Format 
 
   The U.S. Army Corps of Engineers (USACE) has developed a standard file 

format for survey data.  This format is documented in Chapter 6 of 
Engineering Manual (EM) 1110-1-1005.  The USACE survey format 
encompasses a wide range of data types.  The current version of HEC-RAS 
has the capability to read this file format, but only cross section data are 
extracted from the file.  At this time all other data are ignored. 

 
   HEC-2 Data Format 
 
   The HEC-2 program was the predecessor to the HEC-RAS software package.  

The HEC-2 program was used for many years to compute steady flow water 
surface profiles.  Consequently, thousands of data sets exist in the HEC-2 
data format.  HEC-RAS has two ways of importing HEC-2 data.  The first 
way is accomplished through the use of the Import HEC-2 Data option from 
the File menu on the main HEC-RAS window.  When this method is used, it 
is assumed that the user has started a new project; and therefore all of the 
HEC-2 data is imported (geometric data, flow data, and plan information).  A 
second way of importing HEC-2 data is provided from the geometric data 
editor.   This way of importing HEC-2 data allows the user to bring the data 
into existing HEC-RAS geometric data files.  This method also allows the 
user to import multiple HEC-2 data files into the same HEC-RAS geometric 
data file.  However, when importing HEC-2 data from the geometric data 
window, only the geometric data contained in the HEC-2 files will be 
imported.  All of the other data (flow data and plan information) will be 
ignored. 

 
   HEC-RAS Data Format 
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   This option allows the user to combine several HEC-RAS geometry files into 
a single geometry file.  For example, if several pieces of a river system were 
developed as separate HEC-RAS models, this option could be used to put 
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them together into one model. 
 
 
   UNET Geometric Data Format 
 
   This option allows the user to import a UNET geometric data file (CSECT 

geometry file).  UNET is an unsteady flow program developed by Dr. Robert 
Barkau.  The Corps, as well as many other agencies, has used this software 
for many years.  UNET models are often very complex, consisting of many 
river reaches that can be connected in numerous ways.  The HEC-RAS UNET 
importer does not have enough information to draw the schematic in the 
proper manner.  The river reaches and storage areas will be connected 
correctly, but the user will need to edit the schematic to make it look like the 
actual river system. 

 
 
   MIKE11 Cross-Section Data 
 

This option allows the user to import cross section data from the MIKE11 
program.  MIKE11 is a one-dimensional river hydraulics model developed by 
the Danish Hydraulic Institute.  Users must first export the MIKE11 data to a 
raw text file.  This is an available option from MIKE11.  Once the data is in 
the text file format, it can be imported into HEC-RAS. 

 
 

Geometric Data Tools 
 

Several tools are available from the Geometric Data editor to assist you in the 
development and editing of data.  These tolls consist of: cross section 
interpolation; channel modification; graphical cross section editor; reverse 
stationing data; set ineffective flow areas to permanent mode; cross section 
points filter; fixed sediment elevation; pilot channels; and GIS cut line check.  
The cross section interpolation tool has been described previously in this 
chapter.  Channel modification is described separately in Chapter 13 of this 
manual. The following is a short description of each of the tools. 

 
Graphical Cross Section Editor 

 
   A graphical cross section editor is available from the Tools menu of the 

Geometric Data Editor window.  When this option is selected, a window will 
appear as shown in Figure 6.61. 
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   The user has the option to move objects (objects are ground points, main 
channel bank stations, ineffective flow areas, levees, and blocked 
obstructions), delete objects, or add new objects.  To move an object, the user 
first selects Move Objects from the Options menu.  Then move the mouse 
pointer over the object that you want to move, press down the left mouse 
button, and then move the object.  When you are finished moving the object, 
simply release the left mouse button and the object will be moved.  To delete 
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an object, first select Delete Objects from the Options menu.  Next, move 
the mouse pointer over the object that you would like to delete and click the 
left mouse button.  Whatever object is closest to the mouse pointer will be 
deleted.  To add an object to the cross section, first select the type of object 
you want to add from the available list under the Options menu.  Once you 
have selected an object type to add, move the mouse pointer to the location 
where you would like to add it and click the left mouse button.  If the object 
that you are adding requires more than one point, such as blocked ineffective 
flow areas and blocked obstructions, then continue to move the mouse pointer 
and click the left mouse button to add the additional points. 

 

 
 
   Figure 6.61  Graphical Cross Section Editor 
 
 
   Other available options from the Graphical Cross Section editor are the ability 

to zoom in and zoom out, full plot, pan, overlay a grid onto the cross section 
plot, and to undo all of the graphical editing.  When the Undo Edits option is 
selected, the cross section is automatically returned to its original state before 
this particular editing session began.  However, once this editor is closed, or 
if the user selects a different cross section from the editor, it is assumed that 
the user is happy with the changes that were made and they are saved in 
memory.  The data is not saved to the hard disk, so it is still possible to get 
the original data back if needed. 
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   Reverse Stationing Data 
 
   Cross section data should be entered into HEC-RAS from left to right when 

looking downstream.  This is the assumed direction for all of the cross 
sections and other structure data.  If you have data that has not been entered 
from left to right while looking downstream, this editor will allow you to 
reverse the data to the assumed direction.  To bring up this editor, select 
Reverse Station Data from the Tools menu of the geometric data editor.  
When this option is selected a window will appear as shown in Figure 6.62. 

 

 
 
   Figure 6.62  Reverse Cross Section Stationing Editor 
 
 
   As shown in Figure 6.62, you first select the river and reach which contains 

the data to be reversed.  Then select the particular river stations of the data 
that is not in the correct format (left to right looking downstream).  Add those 
locations to the box on the right side of the editor, by pressing the arrow 
button in the middle of the editor.  Continue to do this until you have all of 
the cross section that you want to reverse the stationing for.  Finally, press the 
OK button and the data will be reversed. 

 
 
   Set Ineffective Areas to Permanent Mode 
 
   The default method for ineffective flows is that the area defined as ineffective 

will contain water but have no conveyance (the velocity is assumed to be 
zero).  This remains true until the water surface reaches a trigger elevation (an 
elevation set by the user, as to when the ineffective flow area should become 
effective again).  Once the water surface is higher than the trigger elevation, 
the entire ineffective flow area becomes effective.  Water is assumed to be 
able to move freely in that area based on the roughness, wetted perimeter and 
area of each subsection. 

 
 6-111



Chapter 6  Entering and Editing Geometric Data 

   Occasionally you may have a need to have these ineffective flow areas 
remain ineffective permanently.  The ineffective flow areas can be set to the 
permanent mode individually from the cross section editor, or through a table 
from the geometric data editor.  To bring up the table, select Set Ineffective 
Areas to Permanent Mode from the Tools menu of the geometric data 
editor.  When this option is selected a window will appear as shown in Figure 
6.63. 

 
 

 
 
   Figure 6.63  Editor to Set Ineffective Flow Areas to Permanent 
 
 
   The editor for this option allows the user to select the river, reach, and river 

stations, of the cross sections in which you want to set the ineffective flow 
areas to the permanent mode.  Add those locations to the box on the right side 
of the editor, by pressing the arrow button in the middle of the editor.  
Continue to do this until you have all of the cross section that you want.  
Finally, press the OK button and the data will be reversed. 

 
 
   Cross Section Points Filter 
 
   This tool allows a user to filter out unnecessary points in cross sections.  With 

the use of GIS data, cross sections can contain many more points than 
actually necessary to describe the terrain.  HEC-RAS has a limit of 500 points 
in any cross section.  Because of this limit, it is occasionally necessary to 
filter out points that are not needed.  To bring up this editor, select Cross 
Section Points Filter from the Tools menu of the geometric data editor.  
When this option is selected a window will appear as shown in Figure 6.64. 

 
   As shown in Figure 6.64, the editor allows the user to filter points on a cross 

section by cross section basis, or for a range of cross sections at one time 
(Multiple Locations option tab).  To filter a single cross section, the user 
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selects the river, reach, and river station they want to work on.  Then press the 
button labeled Filter Points on Selected XS to filter the points.   

   

 
 
Figure 6.64  Cross Section Points Filter Editor 
 
 
The cross section points filter performs two different types of filtering on 
each cross section.  The first type is called a Near Points Filter, this method 
simple searches for points that are close together.  If two points are found to 
be within the horizontal and vertical distance tolerance, then the second point 
is removed.  The second type of filter is a Collinear Points Filter.  This filter 
searches for points that are in a straight line, or nearly in a straight line.  This 
filter searches to find three consecutive points that may be in a straight line.  
If a line is connected between points one and three, and point two is less than 
a predefined tolerance from that line (vertical filter tolerance based on a 
distance perpendicular to the line), then the second point is a candidate to be 
removed.  A second check is done to ensure the slope of the line that connects 
point one and two together, is not changing significantly when point one and 
three are connected (minimum change in slope tolerance). 
 
Options are available to only filter cross sections that have more than 500 
points, as well as to restore a cross section back to the original points before 
filtering occurred. 
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Additionally, this editor allows the user to select multiple cross sections and 
perform the filter operation on all of them at one.  This is done by first 
selecting the Multiple Locations tab.  Then select the cross sections that you 
would like to filter.  Set the filter tolerances to any desired values, and then 
press the Filter Points on Selected XS button. 
 
 
Fixed Sediment Elevations 
 
This option allows the user to fill in portions of cross sections with sediment.  
The sediment is assumed to be at a constant elevation in any particular cross 
section.  To use this option select Fixed Sediment Elevations from the Tools 
menu of the geometric data editor.  When this option is selected, a window 
will appear as shown in Figure 6.65. 

 

 
 
   Figure 6.65  Fixed Sediment Elevation Editor 
 

As shown in Figure 6.65, the user selects a particular river and reach to work 
on, then a range of cross sections to apply the sediment fill to.  There are 
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three options for having a sediment fill over a range of cross sections. The 
first option is to enter a sediment elevation at an upstream or downstream 
cross section then project the sediment fill on a slope over the range of 
selected cross sections.  The second option is to set the upstream and 
downstream elevations, then allow the program to use linear interpolation for 
the cross sections in between.  The final option is to set the sediment 
elevation individually on a cross-section by cross-section basis.   
 
The lower left hand portion of the editor is used to set the sediment values 
over a range of sections.  The table on the lower right hand side of the editor 
shows the actual values that are applied to each cross section.  The user can 
change any value in the table directly, or they can highlight a section of 
values and use the three buttons above the table to modify the values.  These 
three buttons allow for adding a constant; multiplying the values by a factor; 
or setting all of them to a specific value. 
 
 
Pilot Channels 
 
Pilot channels are an option that was added for unsteady flow modeling.  
Occasionally, when modeling low flows (such as at the beginning or end of a 
storm event), the program will go unstable. This instability can occur for 
many reasons.  The following is a list of some of the main causes for 
instabilities at low flows:  
 
1. At low flows the depths are very small.  As the floodwave begins to 

come into the reach, the depths change dramatically percentage wise.  
Unsteady flow models us derivatives that are based on the change in 
depth with respect to time and distance.  If the depth changes 
significantly during any time step, the derivatives can become very 
large, and oscillations will occur.  These oscillations can grow to the 
point at which the solution becomes unstable. 

 
2. Also during low flows, it is much more likely that your river may be 

flowing in a pool and riffle sequence.  At the riffles, the flow may be 
passing through critical depth and going supercritical.  The current 
version of the unsteady flow solver in HEC-RAS cannot handle 
supercritical flow, or even flows going down to critical depth.  This 
again causes instabilities in the solution, and may eventually cause the 
solution to go unstable. 

 
Pilot channels are one of the available options to help prevent the model from 
going unstable.  A pilot channel cuts a rectangular notch into the bottom of 
the cross section.  Generally this notch is not very wide (often 1 ft is used), 
but it provides depth to the cross section at low flows (typically make it 5 to 
10 feet deep).  Additionally, the use of a pilot channel can smooth-out 
irregularities in the channel bottom.  This also helps the stability of the model 
solution.  The pilot channel area and conveyance are barrowed from the lower 
portion of the main channel, such that the total area and conveyance 
properties of the cross section relate to the original cross section at higher 
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flows.  In other words, when the depth of flow gets higher, the area and 
conveyance of the pilot channel are ignored.  To use the pilot channel option, 
select Pilot Channel from the Tools menu of the geometric data editor.  
When the pilot channel option is selected a window will appear as shown in 
Figure 6.66. 
 

 
 

   Figure 6.66  Pilot Channel Editor 
    
 

As shown in Figure 6.66, the user selects a river, reach, and range of river 
stations to apply the pilot channel too.  On the lower left hand side of the 
form are some utilities to enter the pilot channel information.  The user enters 
the pilot channel width (typically the width should be narrow), and the 
Manning’s n value (should be equal to or higher than the main channel n 
value).  The user can either enter an elevation for the invert of the pilot 
channel and project it on a slope over the range of cross sections, or they can 
enter an upstream and a downstream invert elevation and have the program 
use linear interpolation for the cross sections in between.   A list of the final 
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pilot channel values for each of the cross sections is shown in the table on the 
lower right hand side of the editor.  The user can modify the table directly and 
change any value on a cross section-by-cross section basis.  The profile plot 
on the editor will display the invert elevation of the pilot so you can compare 
it to the actual channel invert.  Once you have finished adding the pilot 
channel information, press the OK button, and then save the geometric data. 
 
 
GIS Cut Line Check 
 
This tool is used when working with cross section data that has been geo-
referenced.  Geo-referencing a cross section consists of entering coordinates 
for the end points and internal vertices of the cross section (If a cross section 
that is drawn as a straight line it will only have two points to reference.  A 
cross section that is drawn as a series of straight lines will have two end 
points plus some internal vertices.).  To use this tool, select GIS Cut Line 
Check from the Tools menu of the geometric data editor.  When this option is 
selected, a window will appear as shown in Figure 6.67. 
 

 
 
Figure 6.67  GIS Cut Line Check Editor 
 
This tool checks to see if the actual length of the cross section and the length 
along the cross-section cut line match.  If the two lengths are different, you 
will need to adjust the coordinates of the cross-section cut line.  The editor 
shows the length of the cross section cut line, the length of the actual cross 
section, and the ratio of those two lengths.  The cross-section cut line can be 
adjusted automatically from this editor.  The cross-section cut line can be 

 6-117



Chapter 6  Entering and Editing Geometric Data 

made longer or shorter, and you can adjust it at either end or both ends.  The 
adjustment is made using a linear projection from the ends of the cross-
section cut line. 
 
View Reach Connectivity 
 
This tool allows the user to view how reaches are connected together.  When 
working with a very large model with lots of reaches, it can often be difficult 
to see how the reaches are connected, or if there is a problem with a 
connection.  This tool displays the connections in a text table. 
 
Datum Adjustment 
 
This tool allows the user to adjust the data of selected cross sections and 
structures contained in the project.  When this option is selected a window 
will come up that allows the user to select any or all of the nodes (cross 
sections, bridges, culverts, etc…) in the project.  Once the nodes that are to be 
adjusted are selected, the user presses the OK button, and a new window will 
appear allowing the user to enter a factor to multiply or add to all of the 
elevations of the selected nodes. 
 
Fix Overlapping Ineffective Areas 
 
This tool will search through all of the cross sections and check to see if the 
user has entered blocked ineffective areas that overlap each other.  The 
computational program does not like to have overlapping ineffective flow 
areas so this must be rectified before the computations can begin.  This tool 
will find all the cross sections that have overlapping ineffective flow areas 
and it will adjust the stationing of the block with the lower elevation so it 
does not overlap the adjacent ineffective area. 
 
GIS Coordinates 
 
This option allows the user to swap X and Y coordinates or add and multiply 
the coordinates by a factor.  This option is available for river reaches (stream 
centerlines), cross section cut lines, and storage area polygons.  The Swap X 
and Y Coordinate option displays a dialog that allows users to select 
reaches, cross sections, or storage areas, in the current geometry.  Then the 
northing and easting coordinates are swapped.  This option is useful when the 
northing and easting coordinates were entered backwards. 
 
The option to Add and Multiply Coordinates displays a dialog that allows 
users to select reaches, cross sections, or storage areas, in the current 
geometry, then another dialog allows users to enter an amount to add or to 
multiple to the coordinates.  This option is useful for changing the units 
system of the reach line in the schematic. 
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Plot GIS Reach Bounds 
 
This tool allows the user to plot the bounding polygon for GIS flood 
inundation mapping purposes.  When this tool is selected the user is asked to 
pick a particular profile to plot.  Once a profile is selected and the OK button 
is pressed, the bounding polygon for that particular event will be plotted on 
top of the schematic of the river system. 

 
Attaching and Viewing Pictures 
 
   The user can attach a picture to any cross section or hydraulic structure 

(bridge, culvert, etc.).  Once pictures are attached, they can be viewed from a 
picture viewer within the HEC-RAS geometric data editor.  The picture 
viewer supports the following graphics formats: bit map (*.bmp); icon 
(*.ico); windows metafile (*.wmf); GIF (*.gif); and JPEG (*.jpg).   

 
   Pictures are attached to cross sections or hydraulic structures from within the 

picture viewer.  To bring up the picture viewer, go to the geometric data 
editor and click on the View Picture button with the left mouse button.  An 
editor will appear as shown in Figure 6.68.  To attach a picture to a particular 
river station, first select the River, Reach, and River Station in which you 
would like to attach the picture.  Next select the Add Picture button, and a 
file selection box will appear allowing you to select a graphics file to attach to 
the selected location.  If the picture file is not in the same location as your 
data files, you can select the drive and path of the picture from within the file 
selection box.  Once a graphic file is located and selected, press the Open 
button to attach it to the selected location.  The picture should automatically  

   show up inside of the picture viewer.  An example picture is shown in Figure 
6.69.  Additional pictures can be added by selecting a different location, then 
select the Add Picture button to attach the picture.  Only one picture can be 
attached to a model object. 
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   Figure 6.68  HEC-RAS Picture Viewer 
 
  
   Once pictures are attached to the viewer, the user can move to different 

pictures by using the up and down arrow buttons, or selecting a specific river 
stationing that has a picture attached to it.  Options are available to zoom in, 
zoom out, remove pictures, and to resize the picture to fit within the size of 
the picture viewer window.  The user can resize the picture viewer to 
whatever size they want.  However, if you are viewing a bitmap picture, and 
you make the window larger than the actual picture resolution, the photo will 
begin to distort.   

 
   Once pictures are attached to the geometry file, a small red square will be 

displayed on the river system schematic at each location where a picture 
exists.  When the user clicks the left mouse button over a cross section, a pop 
up menu will appear.  If that particular cross section has a picture attached to 
it, one of the menu options will be to view the picture.  Selecting the View 
Picture option from the pop up menu will bring up the picture viewer and 
automatically load that particular picture. 

 
   The pictures are stored as part of the geometry data (not the actual picture, but 

its location on the hard disk).  In general, it is a good idea to keep the picture 
files in the same directory as your project data files.  This will make it easier 
to keep track of all the files associated with a particular project.   
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  Figure 6.69  Picture Viewer with Example Bit Map Photo 

 
 
Saving the Geometric Data 
 
   To save the geometric data, use the Save Geometry Data As option from the 

File menu of the Geometric Data window.  When this option is selected, the 
user is prompted to enter a title for the geometric data.  Once you have 
entered the title, press the OK button and the data will be saved to the hard 
disk.  If the geometric data have been saved before (and therefore a title has 
already been entered), then it is only necessary to select the Save Geometry 
Data option.  When this option is selected, the geometry data are saved with 
the previously defined title. 

 
   In general, it is a good idea to periodically save your data as you are entering 

them.  This will prevent the loss of large amounts of information in the event 
of a power failure, or if a program error occurs in the HEC-RAS user 
interface.     
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